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Introduction

Sage, a recognized leader in accounting software for mid-size
businesses, welcomes you to Sage 500 ERP, business software that
provides superior power, flexibility, and integration with your
existing line of business applications.

In this chapter

About ThisGuide .. ...... ... .. .. 2
Prerequisite Knowledge .................... ... ... .... 3
Sources of Information. .......... ... ... .. . .. . . . . ... 4
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Introduction

About This Guide

Overview

The Getting Started guide provides an introduction to your software, including
explanations of system components and features and the sources of information
available to you.

Information provided
Use this guide to learn the following:
* Sources of information
e Basic system components
e How to log on to the system
* Common processing elements
* How to perform basic tasks and navigate the system
* How to use reporting features

e How to use the Help system
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Introduction

Prerequisite Knowledge

Understanding of Windows-based products

This guide assumes you have a basic understanding of Microsoft Windows.

Sage 500 ERP interfaces with Microsoft Windows-based products, such as Microsoft
Excel and Microsoft Word, and it is assumed that you have an understanding of
these products.

Knowledge of basic accounting
This guide does not attempt to teach accounting, but describes the overall system

and accounting features of the software; an understanding of accounting concepts is,
therefore, required.
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Introduction

Sources of Information

Introduction

As a user of the software, you have access to many sources of information, both
printed and online, as well as customer support services. The following tables
explain the information provided by each of these resources.

Introductory system and setup information

Introductory and system setup information is provided in the following documents.

Resource Information Provided

Getting Started e« Overview of system components and
guide features

e Sources of information

* Explanation of common processing
elements

* Batch processing

* Logon procedures

* Methods of navigation
¢ Using the Help system
* Reporting features

Release Notes Explanation of enhancements and issues
for the latest release.
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Introduction

Configuration and installation

Installation and system configuration information is provided in the following
resources.

Resource Information Provided
Compatibility » Compatibility information matrices
and Resource

. * System requirements
Guide ] .
* System configuration

Installation and e  System requirements

System e Database and client installation
anﬁgurahon procedures
guide

* General installation setup procedures
for the Business Insights Dashboard

* System security

e Software registration

e Procedures and reports for the
System Manager module

BusinessInsights Site hosting, installation and
Dashboard guide configuration, Web site customization,
and troubleshooting

Business Insights Dashboard
How to install and configure Business
Insights Dashboard

User guides
User guide resources include the following documents.

Resource Information Provided

Sample Reports This guide provides samples of reports.
guide

Getting Started 5



Resource

Information Provided

Module PDFs

These guides include the task Help for all
tasks accessible from the Desktop. For
more information, see Procedure Help on
page 134.

Software Development Kit (SDK)

Introduction

Information on customizing your software is provided in the following documents.

Resource Information Provided
Software How to customize modules and develop
Development custom applications, including:
Kit (SDK) ' ¢ The programming techniques used to
]C);nglopers support Sage 500 ERP standards
uide
e Techniques required to customize the
Help system
e This guide is available when you
install the SDK.
Software « How to install the Application
Development Framework or any of the modules'
Kit (SDK) source code.
Insjcallatlon e Hardware, software, and database
Guide .
requirements
e Using a version control tool
This guide is available when you install
the SDK.
Software e Data Migrator architecture
D.e velopment * How to use Data Migrator APIs to
Kit (SDK) Data . .
. load data on an ongoing basis
Integration

Services Guide

e How to customize migrations

Getting Started 6



Introduction

Resource Information Provided

Software e Enhancements

Development e Issues

Kit (SDK)

Release Notes e How to upgrade from a previous
release

e How to use Prestos

This guide is available when you install

the SDK.
SDK Reference The following documents provide
Documents supporting SDK information:

e Software Development Kit (SDK)
Programming Components

e Software Development Kit (SDK)
Development Utilities (used to
maintain system tables)

e Enter Sales Orders and Quotes
Customization Procedures

¢ Design Documents

e API Specifications (stored procedures,
triggers, and tables)

* Schema Browser (used for reading the
data model)

This guide is available when you install
the SDK.
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Help system

Introduction

The Help system contains the following types of information. For more information,
see Using the Help System on page 132.

Resource

Information Provided

Sage 500 ERP
Help system

Overview Help for each task and
related links

Procedural steps for Sage 500 ERP tasks
F1 Field-Level Help
Access to the Help Center

Record layout tables and pre-import
procedures for importing data into the
General Ledger, Accounts Receivable,
Accounts Payable, Inventory
Management, and Cash Management
modules

Module PDFs that you can print as a
reference

Getting Started 8



Support

Introduction

These resources provide additional support.

Resource

Information Provided

Sage Customer
Portal

Internal research database, which includes:

e The Sage Knowledgebase for quickly
locating the information you need

e Downloads, hot fixes, and numerous
other support services

The Support area of the Sage Customer
Portal provides information on the
following:

e Service plans and support topics

e Installation/configuration support
¢ News groups

e Support phone numbers and hours

How to contact Sage

Sage welcomes your comments and suggestions. Contact us at:

Sage

6561 Irvine Center Drive
Irvine, CA 92618-2301
Phone: (800) 854-3415
Fax: (949) 753-0374
http://na.sage.com

Getting Started 9
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System Components

This chapter provides an overview of the products and
components.

In this chapter
CompoOnents . . ... vttt e e 11

Component Features. . . ........... ... . . ... 13
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System Components

Components

The following table shows the components that make up the software.

Component Features
Base system e Desktop
components

¢ System Manager

e Explorer

e Common Information
e Sage 500 ERP Office

e DataPorter

e Data Import Manager
e Sage 500 ERP Alerts

Financials e General Ledger
¢ Accounts Payable
* Accounts Receivable
¢ Cash Management
¢ Intercompany Transactions
e National Accounts
¢ Credit Card

Advanced financials Multicurrency

Distribution e Sales Order
e Purchase Order
¢ Inventory Management

¢ Inventory Replenishment

Getting Started 11



Component

System Components

Features

Manufacturing

Project Accounting

Report writers and
data analysis

Customization
tools

e Light Manufacturing

e Advanced Manufacturing

e Shop Floor Control

¢ Engineering Change Management

¢ Advanced Planning and
Scheduling

e Material Requirements Planning
e Estimating

e Product Configurator
* Project Accounting

¢ Crystal Reports

* Business Insights Analyzer

¢ Business Insights Explorer

¢ Business Insights Dashboard

¢ Application Framework
¢ Customizer

e Source Code

Getting Started 12



System Components

Component Features

Overview

The following tables describe the main features of each component.

For descriptions of associated documentation and additional information resources,
see Sources of Information on page 4. Complete descriptions of module features and
integration capabilities are provided in the Help system.

Base system components

These are the components of the base modules.

Component Features

Desktop Provides a starting point for all system
tasks. Use the Desktop to:

* View menus and launch tasks
¢ Change the company
* Access the Help Center

* Perform system inquiries with
Explorer

For more information, see Using the Sage
500 ERP Desktop on page 35.
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System Components

Component Features

System Manager Use System Manager to:

* Register modules

* Create companies and security
groups

e Define system options, users, and
passwords

* Set user preferences

e Print reports

e Use Assisted Company Setup to set
up Sage 500 ERP. It includes the
data entry and import utilities
available for each step.

e Use Data Migration to insert data
into the system and, if converting
from a supported Sage 100 ERP,
extract the data from the old

system.
Explorer Use Explorer to access system-wide
inquiries.
Common Set up and maintain options and
Information information that are common to one or

more modules. This information
sharing allows you to update data for
multiple modules automatically from
one place.

Information on Common Information
is provided in the Help system.

Sage 500 ERP Sage 500 ERP Office is a set of utilities

Office that allows you to integrate financial
information with the Microsoft Office
suite of applications to create
documents and spreadsheets. Sage 500
ERP Office takes information from, and
attaches files to, Sage 500 ERP entities.

Getting Started 14



Component

System Components

Features

DataPorter

Data Import
Manager

Sage 500 ERP
Alerts

Move data between spreadsheets
and Sage 500 ERP forms

Bring setup data into the system
during conversion or load data on
an ongoing basis

Import pre-defined data entities
into Sage 500 ERP databases

Import entities supported by the
Assisted Company Setup (ACS) task

Import data from SQL Server, Sage
100 ERP, XML, comma-delimited,
text, and Microsoft Access and Excel
files

Automatically monitor your system
for alert conditions and send
automatic e-mail notification to
selected recipients

Customize alert parameters, e-mail
notifications, and scheduling

Predefined base alerts are defined by
the system

Getting Started 15



System Components

Financials
These are the financial components.

Component Features

General Ledger e Set up accounts, account structures,
fiscal calendars, budgets, financial
reports, and journals

e Accept transactions created in other
applications

e Enter and post transactions,
including allocations and recurring
entries

e Set up, enter, and post
intercompany transactions

e Set up and print financial
statements

Accounts Payable « Set up vendors and vendor classes

e Automate many vendor-related
tasks

¢ Process Accounts Payable - Accounts
Receivable settlements

¢ Enter and post invoices and
adjustments

¢ Select invoices for payment
automatically

e Maintain and track detailed invoice
and check histories for each vendor

e Print checks

* Merge two existing vendors into
one vendor

Getting Started 16



Component

System Components

Features

Accounts
Receivable

Cash
Management

Intercompany
Transactions

Set up customers, customer classes,
salespersons, and sales teams

Automate many customer-related
tasks

Process invoices, cash receipts,
finance charges, and commissions

Print invoices and statements

Set up and maintain national
accounts

Merge two existing customers into
one customer

Consolidate multiple shipments as a
single invoice from the same sales
order

Process bank transactions, generate
deposits, and reconcile bank
accounts

Determine cash flow projections

Integrate with Accounts Receivable
to generate automatic deposits and
with Multicurrency to set up bank
accounts in foreign currencies

Integrate with Accounts Payable to
reconcile checks

Process transactions between
companies

Getting Started
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System Components

Component Features

Credit Card e Set up and configure credit card
processing behaviors

¢ Receive credit card payments in
sales orders, invoices, and cash
receipts

e Capture credit card funds during
shipment processing

¢ Daily credit card transaction
settlement integrated with Cash
Management

e Refund credit card payments

e Secured storage of credit card
account data

National ¢ Maintain national accounts, which

Accounts allow you to group customers into a
two-level relationship consisting of
a parent customer and subsidiary
customers

Advanced financials

This is the advanced financial component.

Component Features

Multicurrency * Manage multiple currencies,
exchange schedules, and rate
fluctuations

* Automatically post realized and
unrealized gains and losses to
general ledger accounts assigned
to the currency

Getting Started 18



Distribution

System Components

These are the distribution components.

Component

Features

Sales Order

Purchase Order

Enter sales orders, price quotations,
and blanket orders

Delete sales orders based on security
settings

Automatically update all open order
lines in a sales order with entry
made in the order header controls

Create pick lists and ship lists

Generate invoices, obtain invoice
totals, and print Accounts
Receivable invoices prior to
committing the shipment

Process customer and interbranch
transfer shipments

Process customer returns
Track sales history

Customize the Enter Sales Orders
and Quotes data entry grid and
Favorites tab

Set up buyers, tolerance codes, and
departments

Delete purchase orders based on
security settings

Enter and print requisitions and
purchase orders

Process receipt of goods from
vendors or other warehouses

Process receipt of invoice and
returns

Getting Started
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System Components

Component Features
Inventory e Setup inventory items, item classes,
Management buyers, warehouses, Kkits, and bins

e Set up pricing structures for
products and customers

e Track transaction history and on-
hand quantities

e Process physical inventory

e Process inventory transactions

¢ Process customer returns and RMAs
* Analyze your inventory investment
e Transfer goods between warehouses

e Recalculate inventory quantities

Inventory e Calculate replenishment parameters

Replenishment .
P Process replenishment orders

Manufacturing

These are the manufacturing components.

Component Features

Light ) * Create routings/bills of material

Manufacturing with backflushing (automatic
issues)

* Enter all production information
on one screen, which backflushes
all production components

Getting Started 20



System Components

Component Features
Advanced e Create and track work orders
Manufacturing

e Track outside processor
transactions and job costs

e Produce co-products, by-products,
and disassembly operations

e Make employee assignments

Shop Floor Control « [og employees on and off jobs
* Make labor assignments

e View real-time labor and
production online

Engineering » Process engineering change
Change approvals on routings and work
Management orders

* Notify by e-mail and define
approval sequence

Advanced Planning « Create phantom schedules from
and Scheduling estimating, work orders, sales
orders, and manufacturing
inquiry
* Run production schedules with
finite or infinite capacity
* Automatically schedule and view
work orders

¢ Schedule MRP planned work
orders

Getting Started 21



System Components

Component Features

Material e Use system calculations of supply,
Requirements demand and replenishment of
Planning finished goods, raw materials and

manufactured components

e Create planned and actual
purchase orders for purchased
items

e C(Create planned and actual work
orders for manufactured items

Estimating e Produce detailed estimates using
routing techniques

* Convert estimates to sales orders
or customer quotes with sales
price overrides

Product e Create items and routings

Configurator e Create new routings and bills of

material within the configuration
definition

Getting Started 22



System Components

Project Accounting
These are the Project Accounting components.

Component Features

Project Accounting e Track actual versus estimated costs
through forecast completion

¢ Monitor project details, including
estimates, change orders, purchase
orders, timesheets, and billing

¢ Select from multiple project types

¢ Choose from six GAAP-compliant
profit recognition methods

¢ Seamlessly integrates with the
Accounts Payable, Accounts
Receivable, Purchase Order, and
Inventory Management modules

Getting Started 23



System Components

Report writers and data analysis
These are the report writer and viewer tools.

Component Features

Crystal Reports e Use standard, preconfigured
reports, choosing detailed or
summary information

* Customize reports with a
configurable, user-friendly report
customizer

e Create bar graph and pie chart
reports

e E-mail reports for efficient
distribution

e Export report data to multiple
formats, including Word, Excel,
ASCII, and dBase

e Create and modify business forms
such as checks, invoices, and
statements

Business Insights e Display data in a Data Grid, pivot
Analyzer table, or chart

e Refine data sets using filter tools

e DPort data to the Crystal Report
Wizard

e Export data to Microsoft Excel,
Microsoft Word, PDF, or
eXtensible Markup Language
(XML)

Business Insights * Navigate through data

Explorer e View related data

e Refine and save customized data
sets using filters

* Group or subtotal data

Getting Started 24



Component

System Components

Features

Business Insights
Dashboard

This browser-based application allows
you to consolidate information and
instantly view critical business data.

e Create a personalized view of Sage
500 ERP data, including sales,
product, and customer analyses

e View e-mail, calendars, and
contacts

* View company intranet and
Internet Web sites

Customization tools

These are the customization tools.

Component Features
Application e Build custom applications with
Framework the same look and feel as Sage 500

ERP

e Work with Visual Basic controls,
wizards, and utilities to solve
housekeeping issues, including
concurrency, user interface,
security model, and data handling

e Work with information on the
database structure and an
interactive data schema viewer

Getting Started
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Component

System Components

Features

Customizer

Enables you to customize window
interfaces and functionality by:

e Adding industry-specific features
without making changes to source
code

e Customizing text and fields that
appear on forms and changing
form layout

* Adding new fields to forms and
new buttons to the toolbar using
scripts

* Adding VBScript and Java Script
programming logic to any form
developed with the Sage 500 ERP
framework

Getting Started 26



Starting Sage 500 ERP

This chapter provides the procedures for logging on to your software,
including the use of authentication options. Additionally, you will
learn how to use the Client Configuration Utility to change your
logon settings.

In this chapter

Logging On. ... 28
Authentication Options . . . ........ ... ... ... . .. .. 29
Using the Client Configuration Utility ................. 32
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Starting Sage 500 ERP

Logging On

Procedure

After you obtain a user name and password from your system administrator, start
Sage 500 ERP. You can log on by doing either of the following:

* From the Windows Start menu, select Sage 500 ERP Desktop.

e Right-click the Sage icon in the Windows System Tray and select Login into
Sage 500 ERP Desktop.

e Either method opens the logon window.

=¥ Sage 500 ERP Login x|

[~ UseWindows Authentication

User Mame: Iadmin

Pazsword: I

Campany: ISDA - Systems of America j

v idvanced Options K I Cancel |

Server / Databaze
[” Change Server / Datahase

SHL Server: [C4I51 4533 || Fefresh |

Database: Iﬁ-\pr22_app j

[ Save Setting s Default
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Starting Sage 500 ERP

Authentication Options

Introduction

The first time you log on to the software, you must select the type of authentication
you use for logging on. Your system administrator should be able to provide this
information. The authentication type you use determines how you log on, as
described below.

Option types

Use the following table to determine the authentication type to use.

To use... Do this... To get this result...

SQL Server Clear the Use Each time you start the

authentication Windows software, you are
Authentication prompted for a logon
check box. name and password on

the logon window.

Windows Select the Use  Your Windows user name

authentication Windows and password are used to
Authentication log on. The first time you
check box. start the software, the

logon window appears, so
that you can select the
server, databases, and
company. After that, the
software starts directly
and uses the last server,
databases, and company
you selected.
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Starting Sage 500 ERP

Access rights

For information on granting access rights for Windows authentication, refer to the
Installation and System Configuration guide.

Logging on with SQL Server authentication

To log on to the software for the first time with SQL Server authentication, complete
the logon window as follows:

1

Clear the Use Windows Authentication check box (if it is not already cleared).
At the User Name field, enter your SQL Server user name.

At the Password field, enter your password. (Passwords are required only if
specified in System Manager Set Up Options. For more information, refer to the
Installation and System Configuration guide.)

Select the Advanced Options check box if it is not already selected. This
expands the logon window with fields for selecting the server and databases.

Verify that the server and database fields indicate the server and system and
application databases you want to use. To change the server and database
fields, select the Change Server/Database check box. This enables the server
and database fields and allows you to make your selections.

If you do not see the server or database selections you want, click Refresh. This
lists the SQL Servers in the domain and the databases in the selected SQL Server.
At the Company field, select the company to use.

To log on to the same server and database each time you start the software,
select the Save Setting As Default check box.

Click OK to log on. The Sage 500 ERP Desktop appears. For more information,
see Using the Sage 500 ERP Desktop on page 35.

The next time you start the software, you will be prompted again for your user name
and password.
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Starting Sage 500 ERP

Logging on with Windows authentication

If you are logging on to the software for the first time and you have access rights to
use Windows authentication, complete the logon window as follows:

1 Select the Use Windows Authentication check box. This disables the User
Name and Password fields.

2 Select the Advanced Options check box and the Change Server/Database check
box. This enables the fields for selecting the server and databases you want. If
the options you want do not appear, click Refresh to update the options.

3 Click OK to log on. The Sage 500 ERP Desktop appears. For more information,
see Using the Sage 500 ERP Desktop on page 35.

The next time you start the software, the logon window will not appear. The
program starts directly using the server and database you last used.
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Starting Sage 500 ERP

Using the Client Configuration Utility

Introduction

Use the Client Configuration Utility to change logon and other Windows Registry
settings used by the client software. Use this program instead of changing registry
settings manually.

When to use

Situations for using the Client Configuration Utility include:

Changing logon options when using Windows authentication. When you are
using Windows authentication, the logon window does not appear after the
first time you log on. The Client Configuration Utility enables you to change
to another server and databases, log on as a different user, or change to SQL
Server authentication.

Resolving logon issues. If you get errors when you try to start the software, it
may not have been configured to log on to a valid SQL Server and database.
Use the Client Configuration Utility to select a SQL Server and database and try
logging on again.

Turning off the startup logo. This reduces network traffic when you use
Windows Terminal Server.

Viewing the paths of program and Help files.
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How to use

Before starting the Client Configuration Utility, shut down Sage 500 ERP. Select
Windows Start menu > All Programs > Sage > Sage 500 ERP 2019 > Utilities > Client
Configuration Utility. The Client Configuration Utility window appears.

&= Client Configuration Utility

Apply Ta
(%) Curent Usger ) &l Users
SOL Server Mame | Shasta R
Database Mame  |MAS_app w

|13 Windaws Authertication [
Show Startup Logo

Local Path ... C:\Program FilesSage Software S age MAS &
C:\Program Files'Sage Saoftware'Sage MAS 5
Help Path ... C:\Program Files'Sage SoftwaresSage MAS &

[ Ok H Cancel ] @

Procedure

Complete the window as follows:

1

Select whether to configure settings for all Windows users or only for the user
that is currently logged on.

Select the SQL Server and database to use. If you do not see the server or
database options you want, click Refresh. This lists the SQL Servers in the
domain and the databases on the selected SQL Server.

To log on with the user's Windows logon, select the Use Windows
Authentication check box. When the user starts the software, that person's
Windows logon is used, along with the rights assigned to it. To prompt for a
logon name and password, clear this check box. Users can then log on using a
SQL Server logon name and password.

To prevent the startup logo from appearing each time you start the software,
clear the Show Startup Logo check box. Select the check box to display the logo
each time.
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Common Navigation
Features

This chapter begins by explaining the Sage 500 ERP Desktop: the
starting point for the entire system. You then learn to navigate
the software using the common system and processing elements.

In this chapter

Using the Sage 500 ERP Desktop . ..................... 35
Customizing the Desktop........ ... ... ... ... ... 42
Common MenuUS. . . ..ottt 51
Search Features .. ........ ... . ... . ... . . .. .. 54
System Buttons. . ....... ... .. . . 68
FunctionKeys. ... ... ... .. . i 77
Grids . . o 78
Dates. ... ... e 91
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Using the Sage 500 ERP Desktop

Purpose

When you log on to Sage 500 ERP, the Sage 500 ERP Desktop appears. The Desktop
provides a starting point for all system tasks and enables you to do the following:

¢ Navigate through installed modules and their menus
e Launch Sage 500 ERP tasks
¢ Add and launch non-Sage 500 ERP tasks

e Use the My Tasks pane to customize a task menu structure to fit your daily
business needs

e View tasks in the Recently Accessed Tasks pane

e Access the Help Center (see Help Center on page 137)

e Access information on the latest Sage 500 ERP enhancements

* Change the business date or log on with a different user or company
¢ Launch system inquiries with Explorer

* Move and customize toolbars

e Add and run custom reports (refer to the Installation and System Configuration
guide).
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Exam

ple

Common Navigation Features

Following is an example of the Desktop. For an explanation of each component, see
Components and Navigation on page 37.
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Components and Navigation

Component functions

Common Navigation Features

The following table describes the function and navigation of each Desktop

component.

Component

Function

Navigation

Tasks panes

My Tasks pane

Lists the tasks that enable you
to navigate throughout the
software and launch tasks.

Only those tasks for which you
have access rights are enabled.
Only users with rights can
customize the Tasks pane. For
more information, refer to the
Installation and System
Configuration guide.

This customizable pane enables
you to add frequently used
tasks, shortcuts, URLs, task
groups, and folders for quick
access.

e Expand a task group or
menu to display its
contents.

e Based on your computer's
settings, single-click or
double-click a task name to
launch the task.

* Right-click and select Add to
My Tasks to add task groups
or tasks to the My Tasks
pane.

¢ Right-click to add a shortcut
to the Windows Desktop.

* Right-click and select New
to add a task, menu,
shortcut, custom report, or
URL. The right-click menu is
also used to copy, delete,
and rename tasks.

* Right-click to add a shortcut
to the Windows Desktop.

¢ (Customize the order of
items using drag and drop.
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Component

Function

Common Navigation Features

Navigation

Recently
Accessed Tasks
pane

Content page

Main menu
toolbar

Provides a list of recently
accessed tasks. You can drag
and drop tasks that you have
access to into the My Tasks
pane.

Provides a display area for any
Business Insights task or any
Web page selected from inside
the Desktop.

Provides access to functions
through the following menus:
File, Edit, View, Tasks, My Tasks,
Recently Accessed Tasks, Tools,
Window, and Help.

* Right-click to clear the list
of tasks.

e Set up the number of tasks
to display on the Tools
menu.

e Based on your computer's
settings, single-click or
double-click a task name to
launch the task.

e To open a Web page in a
new window, press
SHIFT+Click inside the
Content page. For more
information on keyboard
shortcuts, see System Buttons
on page 68.

e (Click a menu to see a list of
that window's menu
options.

Select the Find option from
the Edit menu to perform a
search in the Content page.

* Dock the Desktop to the top
of your Windows desktop.
For more information, see
Moving and Docking the
Desktop on page 40.
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Component Function Navigation
Standard Includes the Dock Desktop, Click the Dock Desktop
toolbar Tasks, My Tasks, and Recently button to hide the full
Accessed Tasks buttons. Desktop and dock the
Standard toolbar, My
Toolbar, and Status bar at
the top of your Windows
desktop.
Click the Tasks, My Tasks,
or Recently Accessed Tasks
buttons to select from a list
of the available Sage 500
ERP tasks.
Company Use the buttons on this toolbar Click the Open Company or
Management to open a company or Change Change User button to open
toolbar the currently logged on user. the logon window.
Web Provides the standard Internet
Navigation Explorer navigation buttons,
toolbar including Back, Forward, Stop,
Refresh, and Home.
Menu Use the buttons on this toolbar
Maintenance to create, save, and open task
toolbar menus, if you have access rights
to do so.
Task Use the buttons on this toolbar
Maintenance to add, move, change, and
toolbar delete tasks on a menu, if you
have access rights to do so.
My toolbar A blank toolbar where you can

add your own buttons.
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Component Function Navigation
Status bar Contains information on the  Right-click the Status bar to
status of the Desktop, change the user, company,
including: or business date.
* License type
e Task menu type
¢ Current user and company
e Business date
Desktop Displayed only when the  Click the Show Full Desktop
toolbar Desktop is docked. Includes the button to return the

Standard toolbar and My
toolbar buttons, Status bar
information, Exit, and Help
buttons.

Desktop to its maximized
state.

Click the Help button to
open the Help Center.

See Moving and Docking the
Desktop on this page.

Moving and Docking the Desktop

Docking

When docked, the full Desktop is hidden and the Standard toolbar is docked at the
top of your monitor, providing more free space on your desktop. In the docked
mode, you have access to the following:

e Tasks, My Tasks, and Recently Accessed Tasks menus

e Options for opening, closing, and selecting companies

e Logon window for changing users

e Business date selection window

e Help Center

* Buttons on My toolbar
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To dock the Desktop, click the Dock Desktop button on the Standard toolbar.

=

Example

The following window shows the Desktop in the docked mode at the top of the
Windows desktop.

Click the Show Full Tasks My Tasks Change Help
Desktop button to | company Change Center
undock the

Recently I user
Accessed Exit
| Tasks

Desktop.

-

@ - L3 m [}:ﬂj | @ Change User | Business Date | ]} | 0 -
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Customizing the Desktop

Overview

You can customize the Desktop in the following ways:
* Move Explorer bars, including Tasks, My Tasks, and Recently Accessed Tasks.
¢ Add and change tasks in a menu.

* Customize toolbars, including changing their location, showing and hiding
them, adding or removing buttons, and changing toolbar attributes.

Sage 500 ERP administrators can perform additional customizations. For
information, refer to the Installation and System Configuration guide.

Locking the Desktop

Description

Before performing customizations, unlock the Desktop. When you lock the Desktop,
you cannot perform these customizations. Consider locking the Desktop to prevent
accidental changes.
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Procedure
To lock or unlock the Desktop, from the Tools menu, select Lock Desktop. The icon
next to the Lock Desktop command indicates the present state of the Desktop and

what selecting the command will do.

Icon Description

The Desktop is currently locked.

E Lock Deskbo
P Select this command to unlock the

Desktop.

The Desktop is currently unlocked.

] Lock Deskiop Select this command to lock the

Desktop.

Moving Explorer Bars

Moving bars

When the Desktop is unlocked, drag and drop to move the Explorer bars to another
part of the Desktop or to your Windows desktop.

Returning bars to docked positions

Double-click the title bar to return the Explorer bars to the previously docked
position.

Moving Task panes independently

Double-click the top of the Tasks, My Tasks, or Recently Accessed Tasks pane to
move the three Tasks panes independently.

Tip: When moving the Tasks panes to a position inside the Desktop, place
the tip of your mouse pointer to the edge of the location in which you want
to “drop” the Tasks panes.

Getting Started 43



Common Navigation Features

Adding, Changing, and Grouping Tasks

Description

You can customize the Tasks panes by reorganizing task groups and tasks and by
adding tasks, custom reports, URLs for Web sites, and documents created with other
programs, such as Microsoft Excel and Word.

Use My Tasks for adding and arranging the tasks you want to use. The Tasks pane can
be changed only by users with appropriate access rights. For more information, refer
to the Installation and System Configuration guide.

Commands for customizing tasks

Commands for customizing tasks are available by right-clicking the Tasks panes or
by using the Task Maintenance toolbar. To access the Task Maintenance toolbar,
select the View menu > Toolbars > Task Maintenance.

Adding tasks

To add a task
Right-click the Tasks or My Tasks pane where you want to create the task.

2 From the menu that appears, select Create New Task, then select whether you
are adding a shortcut (to a file or program), task, custom report, or URL.
Complete the window that appears by doing the following:

» For a shortcut to a file or program, type the location of the file you are
adding or click Browse. Type the name that you want to appear in Tasks or
My Tasks.

» For a task, select the module and task. Type the name that you want to
appear in Tasks or My Tasks.

» For a custom report, select the module and custom report. Type the name
that you want to appear in the pane. Type a name and description for the
report and select if the report is Web enabled.

» For a URL, type the Web site address and a name that you want to appear
in the pane.
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Click OK.

Adding from the Tasks pane

You can also add task groups and tasks from the Tasks pane to the My Tasks pane.
Do either of the following:

Right-click the task group in the pane. From the menu that appears, select Add
Task Group to My Tasks.

Right-click the task in the pane. From the menu that appears, select Add to My
Tasks.

Drag and drop the task from the Tasks pane. To separate the Tasks panes,
unlock the Desktop and double-click the My Tasks pane. You can then drag the
My Tasks pane anywhere on the screen. Drag and drop tasks from the Tasks
pane to where you want them to appear in the My Tasks pane. To dock the My
Tasks pane again, double-click the My Tasks pane heading.

Adding from the Recently Accessed Tasks pane

You can add tasks from the Recently Accessed Tasks pane to the Tasks and My Tasks
panes. Do either of the following:

Right-click a task in the pane. From the menu that appears, select Copy and
paste to the pane.

Right-click a task in the pane. From the menu that appears, select Add to My
Tasks.

Drag and drop tasks to the desired pane.

Grouping tasks

You can add and insert a group of tasks to the Tasks pane.

1

Right-click a group of tasks.
From the menu that appears, select Add Task Group.

In the Add Task Group window, type the name for the group, the path of the
content to display, and select the icon to use for the new group.
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4 Click OK.

Using folders to organize tasks

You can use folders to organize tasks in the My Tasks pane. To create a folder

Right-click where you want a folder to appear.

2 From the menu that appears, select Create New Task, then Folder. A folder
appears in the My Tasks pane ready for you to type in a name. Type the name
of the folder and press ENTER.

You can rename a folder by right-clicking it and selecting Rename from the menu
that appears.

Arranging menu items

To change the order of menu items and to place items in folders, do either of the
following:

* Drag and drop them to the desired location.

* Use the arrow buttons on the Task Maintenance toolbar to move items up and
down the list or move them to the left up one level or to the right down one
level.

Deleting menu items
To delete a task group or menu item, right-click it, and select Delete Task Group or

Delete Task from the menu that appears. If a task group or menu item is deleted, you
will need to re-create it.

Customizing Toolbars

Description

You can customize toolbars by doing the following:

* Move toolbars any place on the screen.
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e Select which toolbars appear.
e Add or delete your own custom toolbars.
¢ Add or remove toolbar buttons.

* Set toolbar options.

Moving toolbars

When the Desktop is unlocked, a bar appears on the left side of each toolbar.
|—Bar for moving toolbar

=Y &E
Toolbar Options button

To move a toolbar, click the bar and drag the toolbar to the desired location,
including outside of the Desktop window. To dock a toolbar, drag it to the desired
location near an inside edge of the Desktop window.

Opening the Customize Toolbar window

Use the Customize window to select toolbars to appear, add and delete custom
toolbars, change toolbar buttons, and set toolbar options.

Open the Customize window for toolbars by doing either of the following:

e Select Tools menu > Customize Toolbars.

* Click the Toolbar Options button. From the menu that appears, select Add or
Remove Buttons and then Customize Toolbars.

Getting Started 47



Common Navigation Features

The Customize window appears:

Customize g|

Toolbars | Commands | Options

Toolbars:

Company Managemenkt
Standard

[] Menu Maintenance

[] Task Maintenance

[ My Taalbar

Mew. ..

Keyboard. .. ] [ Close

Creating a new toolbar

To create a new toolbar

1 In the Customize window, click New.

2 In the New Toolbar window that appears, type a name for the toolbar and its
initial location.

Click OK. An empty toolbar appears in the Desktop window.

In the Customize window, click the Commands tab. This tab lists the available
commands for Desktop toolbars including all tasks.

5 Drag the button from the Commands tab to the desired location on the
toolbar.

6 Click Close.

Changing custom toolbars

You can rename or delete toolbars you have created. On the Toolbars tab in the
Customize window, select the custom toolbar. Click Rename or Delete.

Note: You cannot rename or delete a toolbar provided with Sage 500 ERP.
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Changing buttons on toolbars

You can add or remove buttons on custom toolbars and those provided with Sage
500 ERP.

Adding buttons

To add buttons to a toolbar

Open the Customize window.

2 In the Customize window, click the Commands tab. This tab lists the available
commands for Desktop toolbars, including all tasks.

3 Drag the button from the Commands tab to the desired location on the
toolbar.

4 When you are finished, click Close.
Removing buttons

To remove buttons from a toolbar

1 Open the Customize window.

2 Drag the button off the toolbar. The Customize window can be open to any
tab.

3 When you are finished, click Close.
Hiding buttons

To temporarily remove buttons from a toolbar, you can hide them. You can show the
buttons again if you want to use them later.

Follow these steps:

1  Click the Toolbar Options button. From the menu that appears, select Add or
Remove Buttons and then the name of the toolbar. A menu appears with the
buttons on the toolbar. A check appears next to the buttons that are showing.

2 Select the button to hide. It is hidden from the toolbar and the check is
removed.

3 To show the button again, select it again.
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Resetting toolbar customization

To return a toolbar to its default settings, click the Toolbar Options button. From the
menu that appears, select Add or Remove Buttons and then the name of the toolbar.
A menu appears with the buttons on the toolbar. Select Reset Toolbar.

Setting toolbar options

The Options tab on the Customize window enables you to set options for toolbars
and menus, including the size of icons and appearance of menus.

Setting Keyboard Shortcuts

Description

The Customize window also allows you to assign keyboard shortcuts for commands
and tasks. Perform the following:

Click the Keyboard button on any of the Customize window tabs.

2 In the Categories and Command boxes, select the command or task to which
you are assigning a shortcut.

3 Select the key combination in the Specify a Shortcut field. If it is already
assigned to a shortcut, it is indicated below the field.

Note: If you need to return keyboard shortcuts to the defaults, click Reset
All

For more information about keyboard shortcuts, see System Buttons on page 68 and
Using Keyboard Shortcuts in a Line Entry Grid on page 88.
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Common Menus

Introduction

This section provides an overview of common menus and their respective tasks.
Setup tasks are also included on the Maintenance menu.

Detail information

Detailed information on tasks is provided in the Help system.

Menu functions
The following table describes the function of each common menu.

Menu Function

Maintenance e Establish settings and define
information about your companies,
users, and security groups.

e Revise or update information. For
example, in the System Manager
module, use Maintain Companies to add
a new company.

e Use Set Up Options to perform various
functions automatically. These settings
are system wide and affect all users. For
example, you can print user IDs on
reports, require users to enter passwords,
and retry failed data updates to the
server at specified intervals.
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Menu Function

Activities Perform common tasks. For example,
register new modules, purge activity logs for
any module, enter/process transactions,
perform period-end processing, or print

forms.

Reports Print reports that show what activities have
taken place in your system or in your
companies.

Insights * View activity/history in your system or

in your companies.
* Retrieve related data.

e View details of data you currently have
in a summary field.

Tools * Available only in the System Manager
module.

e DPrimarily used by the system
administrator or person responsible for
the setup and configuration of the
system.

e Settings generally affect all users on the
system; however, the User Preferences
menu options affect only the user that is
currently logged on. For more
information, see Setting User Preferences
on page 53.

For more information on using the Tools
menu, refer to the Installation and System
Configuration guide.
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Setting User Preferences

System Manager settings

In System Manager, the User Preferences task on the Tools menu allows you to select
settings that affect only the user that is currently logged on. The preferences you can
set include the following:

Enable the ENTER key to function like the TAB key during data entry.
Use flat toolbar buttons in all windows.
Maximize report windows.

Show the Customizer, DataPorter, and Sage 500 ERP Office buttons on task
window toolbars.

» The Customizer button launches the Customization window, which allows
you to customize task windows.

» The DataPorter button launches an Excel window with a DataPorter
toolbar, which allows you to import data to and export data from Excel.

> The Sage 500 ERP Office button launches the Sage 500 ERP Office window,
which allows you to generate merged documents in Word and Excel.

Use the same business date for all modules.

Use the system date for the business date.

Use the transaction date for the post date for batchless transactions.
Use the system date as the default business date.

Define or change passwords.

Select a default printer for picking and invoices.

Select a default sales order entry warehouse, salesperson, and delivery method.
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Search Features

Overview

Search features help you locate the information you need, without the need to scan
long lists of information.

Search types
The software employs several search features, which are discussed in the following
sections:

* Lookup and Navigator
* GL Account
e Business Insights

Lookup and Navigator

Purpose

The Lookup (the magnifying glass) and Navigator (the flashlight) buttons are query
tools that allow you to access a database table or view information linked to the
current field of your open window.

For information about administering the customization of Lookups, refer to your
Installation and System Configuration guide.
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Example

The following window displays the Lookup and Navigator buttons.

= Maintain Users

vidoX 80 O R

E — Navigator button

Uzer

|
Mame |
|

Default Security Group E — Lookup button

Functions

The following table describes the functions of the Lookup and Navigator search
tools.

Search Keyboard
tool shortcut Function

Lookup FS e TField search

* Retrieves data only for the field
next to the Lookup button

e Fach Sage 500 ERP task window
can have several fields with
Lookup buttons

Navigator F4 e Record search

* Retrieves the complete record
for the selected item

* Only one Navigator button is
available on any task window

* After you select an item, the
selected data is inserted into all
fields referenced in the record
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Search engine capabilities

By clicking the Lookup or Navigator button, you open a database search engine that
allows you to:

Conduct broad or narrow searches per the conditions you define.
Drag and drop to change the row and column order.

Specify filter criteria to display only the data you have selected.
Perform a quick search of data on a single field.

Easily locate a general ledger account.

Customize the appearance of Lookup windows, including the columns that
appear.

Copy the grid data to other programs such as Microsoft Word or Excel using
the Copy button in Lookup windows.

Reset the filtered criteria to view all the data in the grid.

View detailed information for the Lookup and Navigator controls in the Help
system.

Searching for data

Click the Lookup or the Navigator button at a data entry field to start a search. For
more information, see Search in the Help system.
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The Lookup window displays the options for the field that you have defined in your
system. Double-click a row to select an option. The Lookup window closes and the
field is populated automatically with your selection.

Use the Filter tab Click to open or close the Filter tab.

to search for items

by several fields. Drag the border

See Filtering your between the Filter

search on page 58. Sl golup Win o, 0

pag 48 CTER UEX R 00 tab and grid to
change the size.
M e T I ™ Sav Fiter

Up/down arrows

. . . Field Condition
identify ascending Ty o B
or descending sort Lowpary Hene Al

order. b e e Click a column

_ header to sort the
Double-c!lck a row — o 5ystems of America grid by this
to select it. column.

Quick Search

[Company <] [Bogine with = \ seach f— Use the Quick
[rom e P Search fields to
search by a single
field. See Using
Quick Search on
page 58.
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Using Quick Search

Quick Search enables you to search for data by a single field. Select the field and
search criteria in the Quick Search fields and click Search. The results appear in the
grid.

Select the field Select the search  Type the text to search for. (If you
for the search. condition (such select Is Between or Is Not
as Begins with). Between, both fields are
enabled.)

Quick Search
[ Company | [Begins with | [ Search

Click to begin the search.

Filtering your search

To search by more than one field, use the Filter tab. If the Filter tab does not appear,
click the Filter On/Off button.

In the Filter tab, select the search condition and text for each field. If you select Is
Between or Is Not Between, two fields open to the right of the condition so that you
can set the start and end of the range. When you have selected the search criteria,
click the Refresh button.

The results appear in the grid.
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Searching for account numbers

Click the Lookup button next to a general ledger account field to locate an account
number using the Advanced tab.

"4 Lookup Window |Z|E‘ El

28 CTBER BEX KL 0@

View |Standard - [~ Sawe Filker
Eilter 1 Advanced 1
You can enter a —
I Field Condition
natural account, GL Account Humber Al -
a Shortcut |D Description All
’ Aot Type Description Al
and segment Status E
criteria to filter
h [}
t e aCCOUnt GL Account Mumber [ Drescription -
numbers 0000-00-00-00
0000-00-00-5w Suspense-Corp-Corp-5'w Other
1010-00-00-00 Corporate Checking Cash
1011-00-00-00 Canadian Checking Cash T
4 3
Quick Search
|GLAccounl Number leegins with ﬂl ‘ Search
|273 10ws admin [s08 [6/57200 [F
—

Using the Record Filter

After you have closed the Lookup window, you can still use the selection criteria you
made to browse through records in the form.

Use the Record Filter button on a form to retain the most recently defined search
criteria you selected in a Navigator Lookup window.

i

When the Record Filter button is selected, only the records that meet the conditions
last defined in the Navigator Lookup window will display. The filter allows you to
toggle on and off the most recently defined search conditions. If you turn the filter
off, any data that you access is selected from the entire database.

Getting Started 59



Search shortcut
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Quickly perform a search based on text you enter in a field with an associated
Navigator or Lookup button. When you enter text in the field and then select the
Navigator or Lookup button, the search criteria on the Lookup window's Filter tab
automatically populates with your entry, and all related records appear in the grid.

Example

In Accounts Payable Maintain Vendors, select only those vendors beginning with
the letter "A" by typing "A" at the vendor field before clicking the Navigator button.

vdleX 2as 8 e o RRBE

Qur Customer Mo,
Taxpayer ID
DBA

Credit Limit

ACH Tran Code

Custom Fields

Pref Vendar

Vendor lAiNamE\
Main Dfqults
Yendor "4 Lookup Window
Wendor Class
Status
Hald Payment

I Save Filter

Fisld Condition § -]
Vendor Begins with ~|a
Vendor Name Al
Contact Al L]
Vendor DE& Al
Our Cust Nbr Al -
Vendor Contact

Wendor Wame
omp "

o
Advartage Consuling

s Cindy Fopteck

144 p[m]

Ms. Kathiyn R atiiff
AlfTab Alfred Tabasca Alfred Tabasca
AT rade Atlantic Trade Shows Ms. Eilzen Stuber
LT o]
Duick Search
[vendor | [Begins with || Search
‘4 1ows. adrin S04 | B/5/2020 é 4

Saving filter settings

To save filter settings, select the Save Filter check box. The settings appear the next

time you use the window.
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Changing the Lookup Window

Description

You can customize the appearance of Lookup windows by selecting the columns that
appear, their order, and column widths. When you have made the changes, save
them so they are used each time you open the Lookup window.

Changing columns

To change the columns that appear in the grids for the Filter tab and search results,
click the View Columns button in the Lookup window toolbar.

The Lookup View Columns window appears.

Lookup ¥iew Columns E3)

Select the columns ta display in the lagkup.

[T Display only selected columns

Wendar A~

‘endor Mame

Contact Mowve Down
Wendor DBA

Our Cust Mbr ﬁ
Status

O Bank scct

[ Bank Acct Description
O Bark fcct Name

O Bark &cct Mo

O Bark MName

[ Buyer

O Buyer Mame

O compary

[ contact Phone

g B A Help
< >
Column 'width: 2

Calumn Captior: [Vzndor

Driginal Captior: [Vendor

oK LCancel
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Use the window as follows:

To select which columns appear in the grid, select the check box to the left of
the column name. Selected columns appear in the grid and cleared columns do
not.

You can also click the Show/Hide button to select or clear columns. If you select a
cleared column, the button changes to Show so that you can click to select it. If
you select a selected column, the button changes to Hide so that you can remove
it from the grid.

To change the order the columns appear, use the Move Up or Move Down
buttons to move the selected columns. To help you set the column order, select
the Display only selected columns check box to show only the columns you
have selected for the grid.

To change the default column width, use the Column Width field. Set the
number of characters in the column.

To change the title for the column as it appears in the grid, type the new name
in the Column Caption field. The original column name appears in the
Original Caption field for reference. If you have administrator rights, you can
change the original caption.

When you have finished making your changes, click OK. The grid changes according
to the settings you made.

Changing columns in the grid

In the Lookup window, you can change the appearance of the columns in the
following ways:

To change the position of any data column, click the column heading to
highlight it and drag it to another position.

To resize columns, click and drag the column borders within the heading to
adjust the column width.

Saving views

When you close a Lookup window, the column changes you make are retained and
appear the next time you open the Lookup window.
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If you plan to use the column format changes frequently, save them as a view. Views
can include filter settings. When you open the Lookup window, you can select a
view, and it applies the grid layout and filter settings you saved. You can save
multiple views for a Lookup window. One of the views must be set as the default.

To save a view, click the Save As button.

The Save Lookup View As window appears.

Lookup Yiew |
[~ SetAs Default I~ Save Filter
Ok LCancel

Type a name for the view and select whether it is the default view for the Lookup
window, and whether to save filter settings with the view. Click OK.

Note: To change an existing view, type the view name at the Lookup View
field. You are prompted to overwrite the view.

Resetting views

To restore a view to the settings defined by the administrator, click the Reset button.

Deleting views

To delete a view, click the Delete button. This button is disabled for views created by
the administrator.
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GL Account Structured Search

Purpose

The GL Account Structured Search provides an additional method for locating
general ledger account numbers. Unlike the Navigator or Lookup search, which
organizes general ledger accounts by number, the structured Search window uses a
hierarchical tree view that organizes the accounts by account category and account
group. This type of search is useful in finding a particular account number when you
know the account function or type.

Example

Click the Structured Search button to open the GL Account Structured Search
window.

= G| Account Structured Search Window: ‘Z‘@ng

e Cle D

Account Number ‘ D escription

@ Liabiliy

& Equity

& Revenue

@ Cost of Sales

@ Other Income and Expense
® Income Tax

W Expense

@ NonFinancial

] [ 3 ) [ [

»
| [acmin [s0a 6572020 |5,

More information

For more information, see the Help system.
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Business Insights

Purpose

Use Business Insights features to view and edit stored information as you work. For
example, you might want to view a customer's account aging and their latest
payment information. You can access this type of information by right-clicking the
selected fields for which details are available or by selecting a task from the Business
Insights menu.

Business Insights Options

There are five ways to view or edit related information while you are processing a
transaction:

* Explore

e Previews

e Drill Into

* Analyze

¢ Manage

To edit or view historical information, right-click a primary field and select the
appropriate option.
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vHIOX| 22 @ @ RR
Posting Date: 06/012/2008 Reversing Dale
Joumal 50 S| EntyNumber [000z87 S| | % NetBalance:  $0.00
Sales Joumal
Right-click a field
9 . Compary [S0A  v| Systems of Ameiica
to display a menu Acoount | - - als Reeemme [ &
that lists Business ] Explore Gl Accourks
Previews »
Insights options. Debit Dril Into » $0.00 [ 0.0000
Analyze »
Bt ’— Manage v = oK
What's This? Urda
Compary coount Rcference Debit
1
4 | »
] 4[> [m]Y| acmin [s0 [6/502020 [,

Explore

Explore options allow you to view data in the context of a selected field. For
example, if a general ledger account field is selected, you can view data for the

selected general ledger account.

Previews

Previews options allow you to quickly view grids of related data.
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Drill Into

Drill Into options allow you to view related data, such as general ledger transactions.

== Explore - GL Transactions

File Edit View Freview DrilInto Analyze Manage Insights Tools Window Help

Setting

GL Account Post Date Post Amt | Fiscal Period Batch Joumal
79 rill Into r 1010-00-00-00 | Corporate Checking 142/2007 500.000.00{ 2007 - 1 CMCM-0000 | Cash tanageme:
= 3 Ascourls ’— 1010-00-00-00 | Corparate Checking 172002007 (16.2568.79)| 2007 - 1 GLGO0003 [ Joumal Entry
5 Standard [ 1010000000 | Corperate Checking 292007 | (15.256.79 2007- 2 | GLGH00004 | Joumal Enty
r 1010-00-00-00 | Corporate Checking 21/2007 (16,258.79)| 2007 - 3 GLGJ-00005 [ Joumal Entry
r 1010-00-00-00 | Corporate Checking 4/22/2007 (16.268.75)| 2007 - 4 GLGHO0008 [ Joumal Entry
r 1010-00-00-00 | Corparate Checking 5/19/2007 (16.258.79)| 2007 - & GLGH00007 [ Jeumal Entry
’— 1010-00-00-00 | Corparate Checking £/20/2007 (16.25879)| 2007 - & GLGO0008 [ Joumal Entry
’7 1010-00-00-00 | Corporate Checking 7/23/2007 m 2007 7 GLGJ-00009 [ Joumal Entry
r 1010-00-00-00 | Corporate Checking 8/13/2007 (16.268.75)| 2007 - & GLGIH0000 [ Joumal Entry
r 1010-00-00-00 | Corporate Checking 8/20/2007 (16.268.79)| 2007 - 9 GLGI00011 [ Joumal Entry
’— 1010-00-00-00 | Corparate Checking 1072042007 | (16,258 79)| 2007 - 10 GLGIHOOM3 [ Joumal Entry
[ 1010000000 | Corperate Checking 1172172007 | (16,256.73)| 2007 -11 | GLGIO0014 | Jewamal Entiy
r 1010-00-00-00 | Corporate Checking 12A17/2007 | (16,298.79)| 2007 - 12 GLGJ000MS [ Joumal Entry
r 1010-00-00-00 | Corporate Checking 1/31/2007 400.000.00{ 2007 - 1 CMCM-0000 | Cash tanageme:

r 1010-00-00-00 | Corparate Checking 1/31/2007 1 ARCR-0000 | Cash Receipts

’— 1010-00-00-00 | Corparate Checking 1/31/2007 1 ARCAR-0000 | Cash Receipts

’7 1010-00-00-00 | Corporate Checking 143172007 -1 ARCR-0000 | Cash Receipts

r 1010-00-00-00 | Corporate Checking 1/31/2007 1 ARCA-0000 | Cash Receipts

1010-00-00-00 | Corporate Checking 1/31/2007 1

1" Analyze

ARCR-0000 | Cash Receipts ..

P Manage

Analyze

Analyze options allow you to view pivot tables and charts for related data.

Manage

Manage options allow you to perform tasks related to selected data.

More Information

For more information, see the Help system.
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Button functions

The following tables define the system buttons used throughout the software. Use

keyboard shortcuts to initiate many of the same functions provided by these

buttons.

Toolbar buttons

Button Name
[keyboard shortcut] Function
— Sage 500 ERP Office  Opens Sage 500 ERP
kgl [CTRL+SHIFT+E] Office.
i
= Cancel Clears the currently
@ [CTRL+L] entered, unsaved data
and keeps the task
window open.
n Cancel and Exit Clears the current
Ly [CTRL+SHIFT+L] window and returns you

Cancel Process

Change Business
Date

to the Desktop or to the
main window of the
current task.

Cancels the current
Business Insights process.

Changes the system
business date.
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Name
[keyboard shortcut]
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Function

[

g

2

Change User

Close
[CTRL+Q]

Commit
[CTRL+T]

Copy
[CTRL+C]

Customizer
[ALT+F3]

DataPorter
[ALT+F7]

DataPorter Metadata
[ALT+F8]

Click to change the
currently logged on user.

Closes the window.

Commits a shipment or
customer return.

Copies the selected
information or graphic to
the clipboard.

Opens the Customization
window, which allows
you to modify the
window.

Opens Microsoft Excel
with the DataPorter
toolbar, which allows you
to import data from and
export data to Microsoft
Excel.

Opens the DataPorter
Metadata window, which
allows you to create the
infrastructure DataPorter
requires to create the
spreadsheet, and import
or export data.
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Name

[keyboard shortcut]
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Function

Defer
[CTRL+F]

Delete
[CTRL+D]

Dock Desktop

Export Report
[CTRL+SHIFT+X]

Finish
[CTRL+F]

Finish and Exit
[CTRL+SHIFT+F]

Help
[CTRL+H]

Delays printing of the
current report/list, saves
it, and places it in the
repdata folder in System
Manager. For more
information, see Deferred
Printing on page 126.

Deletes the selected
record.

Hides the full Desktop
and docks the Desktop
toolbar at the top of your
Windows desktop.

Exports the report to a
third-party package, file,
HTML, or e-mail, such as
Excel, Word, Exchange,
or Outlook.

Saves the current entry
and clears all data from
the window; the window
remains open.

Saves the current entry
and closes the current
task window.

Opens Form-level
(overview) Help. See
Using the Help System on
page 132.
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[keyboard shortcut]
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Function

Y

Help Center

Memo
[CTRL+M]

Memo
[CTRL+M]

Memo
[CTRL+M]

My Tasks
[ALT+M]

Next Number
[CTRL+N]

Opens the Help Center.
See Help Center on
page 137.

Allows you to enter a
memo for the current
record. After the memo is
saved, the Memo icon
changes to indicate a
memo exists for the
record.

Allows you to enter a
memo for the current
record or change an
existing memo. Indicates
a memo already exists for
the selected record.

Allows you to enter a
memo for the current
record or change an
existing memo. Indicates
a priority memo already
exists for the selected
record.

Displays the My Tasks
pane.

Assigns the next available
number in an
automatically numbered
field.
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Function

B

)

Open Company

Preview
[CTRL+W]

Print
[CTRL+P]

Proceed
[CTRL+O]

Refresh
[CTRL+SHIFT+R]

Rename ID
[CTRL+R]

Recently Accessed
Tasks

Click to change the
current company.

Displays the current
report or list

on the screen. For more
information, see
Previewing Reports on
page 124.

Prints the current report
or list.

Begins processing.

Refreshes data in the
current window.

Assigns a new ID to the
current record. All
historical information is
tracked under the new
ID.

Displays the Recently
Accessed Tasks pane.
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Function

Button Name
[keyboard shortcut]
Reset

E [CTRL+SHIFT+R]

= Save

LEEI [CTRL4+S]

Search Text

Stop
Tasks
£ [ALT+T]
- Tree View
=
=
Zoom
9% -

Resets the entry and all
data displayed in the
window.

Saves the current entry,
and all data remains
displayed in the window.

Searches for specific
information on a report
or list. Used in
conjunction with the
adjacent text entry field.

Halts printing of a
multiple page report. This
button is enabled only
when printing a multiple
page report.

Displays the Tasks pane.

Toggles the tree view to
the left of the report
preview window on or
off.

Resizes the page in the
display window. Use the
down arrow to select Page
Width, Whole Page, or a
percentage.
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To view buttons that can be added to toolbars, use the Customize Toolbar command
in the Tools menu when the Desktop is unlocked. For more information, see

Customizing Toolbars on page 46.

Additional buttons

Button Name

[keyboard shortcut] Function
— Export to Excel Export data to Microsoft
5% 4 [CTRL+SHIFT+E] Excel.

Y

I4

Filter (On)
[CTRL+B]

Filter (Off)
[CTRL+SHIFT+C]

Go to First Record
[CTRL+SHIFT+U]

Toggles the display of the
filter criteria in a Lookup
window.

When selected in a
Lookup window, displays
the Filter tab to limit the
information that appears.
If filtering on a general
ledger account field,
displays the Advanced
tab to further limit the
information.

Cancels the filter criteria
in a Lookup window.

Opens the first record in
the database or
Navigator, depending on
the Record Filter mode.
For more information, see
Using the Record Filter on
page 59.
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Function

i

L

Go to Last Record
[CTRL+SHIFT+O]

Go to Next Record

[CTRL+SHIFT+P]

Go to Previous
Record
[CTRL+SHIFT+I]

Map
[ALT+Q]

More

Opens the last record in
the database or
Navigator, depending on
the Record Filter mode.

Opens the record
following the current
record loaded in the
window in the database
or Navigator, depending
on the Record Filter
mode.

Opens the record
preceding the current
record loaded in the
window in the database
or Navigator, depending
on the Record Filter
mode.

Displays a map for the
address displayed in the
window.

Opens a window where
you can enter additional
information.
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Name

Button [keyboard shortcut] Function

Record Filter On/Off When used in
? [CTRL+T] conjunction with the
Navigator, limits the

search information
available for display. For
more information, see
Using the Record Filter on

page 59.

Structured Search Enables you to select an
Ei’ [SHIFT+FS when item from a heirarchical

next to a Lookup, list, such as general ledger

SHIFT+F4 when next accounts and payments

to a Navigator, or and inventory items.

CTRL+SHIFT+T

when it appears by

itself]
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Function Keys

Definitions

Use your keyboard function keys to perform the following actions:

Key

Function

F1

F3

F4

FS

F12

ALT+F3

ALT+F4

ALT+F7

Displays help for the current field while in a task.
You can also right-click > What’s This? in the
current field of each task.

Updates (or refreshes) the field with data added
since opening the window.

Opens the Navigator search window to retrieve
data for all related fields in the current window.

Opens the Lookup search window to retrieve data
for the current field.

If account shortcuts have been defined in General
Ledger Maintain Account Shortcuts, use the F12
key when in the Accounts field to enable the
shortcut, which automatically enters the full
general ledger account number. For more
information, see the Help system.

Opens the Customization window for the current
Sage 500 ERP window. For more information, see
the Help system.

Closes the current Sage 500 ERP task window.

Opens DataPorter. For more information, see the
Help system.

You can define additional keyboard shortcuts. For information, see Setting Keyboard
Shortcuts on page 50.
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Grids

Populating a Grid

Entering data

To populate the grid, enter data in the required fields above the grid. In the
following example, you must enter data in the Company and Group fields. Press
ENTER or click OK to transfer the data to the grid.

=F Maintain Users EI[EE\
vH @X @D R&E

User [ ﬂ J g

Hame |Jnhn Srith

Default Security Group |pub\ic E
Group Description |
Task Menu |Standard j

Menu Description |

Roles
Use gpplication Role r r
DI Package User I

DI Package Administrater [

Compary E Ok
Group [ % Undo
Group Description ‘
Company Group Description

1 S04 Sypsédmin |System Administrator

2 COA ARMo Accounts Receivable Manager

]
4| | 3
ZIRIEIN ! sdvin 504 [6/5/2020 [
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Options for editing
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Depending on the type of grid you are working with, there are two ways to edit text

in a grid:

e Click the grid line to select it. This causes the fields above the grid to populate
with information. You can then change the data in these fields and click OK to
update the data in the grid.

Select a row in the grid
to display the

information in the fields
directly above the grid.

= Maintain Users

vd @xX 60D B &R
User [ ﬂ J g
Hame |Jnhn Srith
Default Security Group |pub\ic E
Group Description |
Task Menu |Standard j
Menu Description |
Raoles
Usze Application Fole I r
Dl Package User I
DI Package Administrator [
Comparny S04 E Systems of America
Graup \ Sysddmin E
Group Description ‘
Company Description
1 EE & & strator
2 COA ARMagr ounts Receivable Manager
3 |
| | »
ORI, sdmin 50 [6/502020 |5,
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Select the grid line and make the changes to enabled fields inside the grid.

== Maintain Security Groups Q@El

vdlleX eo @ BRE
Secuity Group | ﬂ Copy From ‘
Description |Accuunts Fieceivable Manager
Module 1D SM w | System Manager
Tasks T Security Events W
todule Task Description . Permission =
1 SM | Lookup View Maint Marmal -
2 SM | Maintain Lookups Marmal e
3 SM  |Menu Uparade Utility Marmal
4 SM | Set Up Busingss Insights Configuration Excluded
5 SM | Maintain Business Insights Views / Contest Menus Excluded
B SM | Task To Table Security Excluded
7 SM_|Local Object Infarmation Excluded
g SM|User Maintenance Excluded hd
Default Permission
RTINS acrin 504 [sia200 [F

Customizing Columns

Ways to customize

in a Grid

Columns in a grid can be customized in the following ways:

* Click and drag the edge of the column heading in some grids to resize the

column width.

* Sort the order of column lines in some grids by clicking the column heading.

* Click the column heading and drag the column to another location.

Note: When you resize columns in a grid, the new sizes are not saved when

you close the window.
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"4 Lookup Window:

28 Cc7TP? BRAX HNLo@
. i Standard | ¥ [~ SaveFilt
Up or down arrows in—— Storcix | ave e
the column heading Eite |
identify an allscendlng Field Candiion
or descending sort Campany &l ~
order Company Mame Al
k —
Compary E Company Mame
== System Status Q|E\@
. . 2ol DR
Resize the width of 7 3 ]
. Dptions and Settings C i
each column in the : :
X . Process ID Status User | Blooked Desaription mpan me | WISCient | WIS Command
grid by dragging the T - :
57 skeping admin 0 Managed Session SOA CAIS00202 EVAITING COMHAND
edge of the column 88/ sleeping admin 0 Object Manager CAI500282 AWAITING COMMAND
. 89 clesping_ admin 0 System Status Monitor 504 CAIS00282 AWATING COMMAND
to the rlght or left. 70/ sleeping admin 0 Application CAI500282 AWAITING COMMAND
Al ,
[Last Refests 5/17/2009 11:353.02.4M _ Het Refresty: Manual [scmin [s0a [ e/mvamen [F

Selecting a Row in a Grid

Ways to select
Rows in a grid can be selected in two ways:
e Select each row by clicking the row numbers that appear at the left of the grid.

e Select a range of rows by clicking a row number, and then clicking another row
number while holding down the SHIFT key.
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Working with Lines in a Grid

Line options

When you click a line in a grid and then right-click, a menu appears that allows you
to:

e Add a line.

¢ Delete a line.

* Select Business Insights tasks.

Export and print options

Some grids also allow you to right-click to:

e Export the data in a grid to an Excel (.xls) file format.

e Export the grid data to a template (for more information, see Exporting Grid Data to
a Template on page 84).

e Print the data in the grid to the default Windows printer.
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Moving lines

In some grids you can move a line by clicking the row number and dragging the row
to the desired location.

=¢ Maintain Customer ltems Ll@‘gl
vd @8 |d RR
Customer  [Aldebrn E Aldebaran. Inc.
Customer ltems
Itemn Explars Ttems tion Custamer Ite}
28.8 Modem Previeus , [B3EK 44KV
Cable100 orill Tnko N C100F
Cahle200 fnalyze N C200F
Cablef0 Manaae y COS0F
Cabie500 ° CS00F
UPS ply
1000 Yiper
Export
| | 3
Print
ZIRINACIN hat's This? acin [508 [6/5/200 [F

Getting Started 83



Common Navigation Features

Exporting Grid Data to a Template

Overview

The Export to Template feature enables you to export data from a grid to an existing
Excel file. This file may contain preformatted views of the exported data, such as
pivot tables and graphs. It is assumed you have some familiarity with Microsoft
Excel.

The Export to Template option appears on right-click menus associated with grids.
At least one template must be associated to the form for this option to be enabled. To
associate an Excel template to a form, see Template association on page 86.

Template selection

When you select Export to Template:

* An Excel export template is selected.

* If no template is selected, a new Excel workbook is created.

e Contents of the grid are exported to the selected Excel template.
e The Excel workbook created using the template is displayed.

If there is only a single template associated with the form, then it is used, providing
it exists. If more then one template is associated with the form, you select a template
or browse to a template from the Export Template Selection window.

Creating an Excel template

Each Excel template created to use the Excel Export to Template feature must be
formatted to use the latest exported data. To create a new template:

1 Select the task for which you want to create a template. The window must
contain a grid.

In the task window, select the desired options to populate the grid with data.

Right-click the grid and select Export. This option creates an Excel spreadsheet
that contains the raw grid data.
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Rename Sheet 1 to Source. This worksheet will be refreshed each time you
export to this template.

From the Excel Insert menu, select Name and then Define.

[
= (=1E9
i8] Ble Edt View Inssit Formab ook Data  RoboPDF  Window Help Type a question forhelp v 2 @ X
RN NIRRT R AR NS T 10 LN KR
HiE] )
Al - A ltem
| & B I C [0 T & T F T & =

1 [em i Customer Item Number

2 [28.8 Modem Couier 288V Everything = 3

3 [Cabled 00 00 Standard Cable Define Name E\

4_|Cabls200 $2000 Standard Cable S

5 |Cables0 i Standard C bz LIS

& [Catls) S SendsdCable | |

7 |UFS ] Pawer Sup] & 3

g |00 Wiper 1000

k]

o

T

13

14

x Refers tor

i —Sourcel$ag] ke

18

18

E]

= ™
W 4 » w\Source S |« 3|
Ready UM

Notice the named range called Sourcelnfo that includes all columns and rows.
The named range is updated each time the template is used to reflect the
correct number of columns and rows. Any references made to the source
worksheet from other worksheets should reference this named range. This
ensures that when the template is opened and the worksheets are refreshed, it
will reference all rows and columns generated in the source worksheet. (Excel
does not recognize when new rows are added to a worksheet that may affect a
named range.)

Create additional worksheets that reference the source worksheet. Include
pivot tables and graphs, as desired.

Save the template to an Excel file. Use the naming convention defined in
Template association on this page. Additionally, you can save multiple templates
per task. In this scenario, use a name that reflects the given task and add it to
the template list file, as defined in Adding a template to the template list file on this

page.
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Template association

Each form can have multiple Excel export templates associated with it. These
templates are located in the GridTemplates folder under the client installation
folder. A template can be associated to a form in two ways:

* The template is located in the GridTemplates folder, and the filename and
form caption are the same.

e The template is associated to the form by an entry in the TemplateList.xls file.

Adding a template to the template list file

The template list file TemplateList.xls can be used to associate one or more Excel
templates to a specific form. When using the Template List file to publish templates
for a given form, the actual template can reside in any folder; however, the
TemplateList.xls file must be located in the GridTemplates folder.

If you do not have a folder called GridTemplates in your client folder (default -
C:\Program Files\Sage Software\Sage MAS 500 Client), you must create this folder,
as well as an Excel file named TemplateList.xls (located under the GridTemplates
folder) to proceed.

Example Template List spreadsheet

3 Microsoft Excel - TemplateList.xls

(] Fle Edit Wew Insert Format  Tools Data  EoboPDF  window  Help  Adobe FDF Type a questi rhelp = o & X
G E e PR ® S F e 8 F - B R 0 - @ i - S [
iigg d=g A T Ry (V) i3] ¥ Replywith changes,. Endpeview... [
AB h b3
A [ B | C | D =

| 1_|[Form Caption Template File Template Description
| 2 |Mairtain Customer ltems MaintainCustomeritemns. xls Ernpty Mairtain Custormer ltems template
|3 |Enter Sales Orders and Quotes  EnterSalesOrdersandQuates.xls | Enter Sales Orders and Quote template
| 4 |Mairtain ftern MaintainitemUom. xls Maintain tem Unit of Measure

5 Maintain ltern Miantainltemimages. xls Maintain ltem Images

5
| 7
=N

E]
o

1
2|
| 13|
[ 14
| 15|
| 16|
17|

18

18 3
W <« » wh\Sheetl [ Sheet2 { Sheeta / 3 ]
Ready HUM
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Guidelines
Use the following guidelines to add a template to the TemplateList.xls file:

* The template must contain a single worksheet; the worksheet name is not
significant.

e The worksheet must contain three columns, in this order:

> Form name (not case sensitive).

> Excel export template file name. May contain path information. If no path
information is included, the default path to the GridTemplates folder is
prefixed to the file name.

> Template description. This description appears in the Export Template
Selection window.

e The columns must have a header row. The first non-blank row is considered
the header. The text on the header row is insignificant.

Using Grids to Select Report Criteria

Purpose

Report grids allow you to define and sort multiple selection criteria for each report.

Sort grid

The items in the Sort grid determine the order in which items are sorted on the
report, if subtotals are used, and whether to insert page breaks after selected fields.
Fields on which you can sort depend on the type of report you are printing.

Example

The Print System Activity Log includes sort options for the event date and event
time.
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=® Print System Activity Log Q‘Elg]
SEBL EHX O @
Setting [By Date ~| [~ Prirt Report Settings
Main | Options
Sart
Field Sort Order Subtotal Page Break B
: Event Date [Escending - r r
Sort grid — = = |
T T
T T
r [N -
[ seleet
Field Al
Company 2l
Select grid— ||| [Eventate &l
Event Descriplian &l
Event Program Is equal to 5]
Or Event Program ~ |[ls equal ta 15|
User &l
adrin 502 [6/5/2020 [ 5

Select grid
The items in the Select grid determine which records appear on the report, based on
the criteria you enter. For example, you can right-click an item in the Field column,

which enables you to select a range of values for your report. And indicates required
inclusion; Or indicates optional use of the specified value.

Using Keyboard Shortcuts in a Line Entry Grid

Shortcut definitions
Keyboard shortcuts are described in the following table.

Keyboard shortcut Function

ALT+HOME Moves the cursor to the first field
above the grid

ALT+END Returns the cursor to the row
previously highlighted in the grid
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Keyboard shortcut Function

SHIFT+END Displays the far right column cell in
the grid

SHIFT+HOME Displays the far left column cell in
the grid

HOME Displays and highlights the first line

or first column cell in the grid

END Displays and highlights the last line
or last column cell in the grid

Up or Down arrow Moves the cursor from row to row

CTRL+Up or Down  Repositions a highlighted row to a
arrow new position in the grid

CTRL+Up or Down  Drags the current grid line entry up

arrow or down one line

ESC Cancels the current entry and moves
the cursor from a data entry field to
the grid below

ENTER Moves the cursor from a highlighted
grid line up to a data entry field for
editing

PAGE UP Moves the cursor to the first line

PAGE DOWN Moves the cursor to the last line

CTRL+G Displays the Goto Line window,

which allows you to position the
cursor at a line number in the grid
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Using a Mouse to Edit Data in a Grid

Options

To use your mouse to modify or edit data in a grid, you can:

e Right-click the grid to display a menu that allows you to add, delete, insert, or
go to any row.

* Click and hold (drag and drop) a row or column heading on the grid to move it
to a new position in the grid (if the grid supports reordering).
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Dates

Definitions

There are several different types of dates used by the software, which are described in
the following table.

Date type Description
Business date e The default transaction and posting
date.

e FEach module can have its own
business date.

¢ Defined in System Manager.

Transaction date e The date of the actual transaction.

e Used to age invoices and vouchers.

Posting date e The date the transaction was
posted.

e Some reports include information
based on this date (for example,
Trial Balance).

Run date e The current system date.
e Appears on reports.

e Does not affect postings.
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Viewing and
Analyzing Data

This chapter provides information and procedures for using the
Business Insights Analyzer, Business Insights Explorer, and
Business Insights Dashboard.

In this chapter

Using the Business Insights Analyzer................... 93
Using the Business Insights Explorer .. ................ 100
Using the Business Insights Dashboard ... ............. 103
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Using the Business Insights Analyzer

Purpose

Business Insights Analyzer allows you to identify, analyze, display, and report
different types of data, such as projects, sales activities, or general ledger activity.
Use the Business Insights Analyzer to perform the following functions:

¢ Display the data set in a Data View grid, pivot table, or chart.

Note: If you have the supported version of Microsoft® Office installed on
your PC, the pivot table and chart are used interactively. For information
on supported versions, refer to the Sage 500 ERP Compatibility and Resource
Guide.

e Refine data sets using filter tools.

¢ Add columns or remove columns that do not apply to the data search.
¢ Group or subtotal data.

e Print the Data View grid and chart information directly.

¢ Port the data to the Crystal Report Wizard.

e Export the data to Microsoft® Excel®, Microsoft® Word®, PDF, or the eXtensible
Markup Language (XML).

e Save multiple settings for each Analyzer task.

Accessing the Business Insights Analyzer

There are several ways to access Business Insights Analyzer, depending on your
workflow needs. You can access Business Insights Analyzer directly from a window in
the software or from the Tasks pane located on the Desktop. You can also access the
Analyzer from a Business Insights Explorer task.
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To access Business Insights Analyzer from the software:

1

In any window in the software, right-click the field that has the Business
Insights Analyzer feature available.

On the right-click menu, select Analyzer, select the task, and then select the
filter setting name.

Note: If no customized filter settings have been saved, Standard is the only
filter that displays.

The Business Insights Analyzer window appears with the data for the selected
task and filter in view.

To access Business Insights Analyzer from the Desktop:

1

In the Desktop, on the Tasks pane, click the Business Insights task group.
Expand the Analyze folder.

Double-click an Analyzer task. The Business Insights Analyzer window appears
with the data for the selected task and filter in view.

To access the Analyzer from a Business Insights Explorer task:

1

In the Business Insights Explorer window, select the Analyze menu or the
Analyze group in the Explorer bar.

Expand the folder for the data that you want to view.

Select the type of setting to use. Standard is the default setting unless you
create a new setting and designate it as the default.

The Business Insights Analyzer window appears with the data for the selected
task and filter in view.
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Using the Business Insights Analyzer Toolbar

Example

The illustration below provides more information about the features available on the
Business Insights Analyzer toolbar.

@E‘?\E\Z'L@l 5 8=~ G e [ = E @ S-E G B 0 setting|standard i
Use the buttons on the Analyzer
toolbar to modify settings and filters, Use the Setting drop-down
and select options for the Data View list to select a saved
grid, pivot table, and chart. setting or the Standard
setting for the Analyzer
“Use the Filter pane to “fine task. You can save
tune” the data set for the multiple settings for each
Analyzer task for improved Analyzer task.

analysis and performance.

More information

For more information, see the Help system.

Viewing Data in the Business Insights Analyzer

Overview

After entering a filter and clicking the Refresh button, the resulting data set initially
displays in the Data View grid for the Analyzer task.
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Example

You can view data in a Data View grid, pivot table, or chart by clicking the tabs
located in the lower-left corner of the Business Insights Analyzer.

More information

For more information, see the Help system.

Creating Filters

Procedure

Use the following steps to enter one or more filters that can be applied to any
column in the data set.

On the Analyzer toolbar, click the Show Filter button. The Filter pane appears.

2 At the Column field, select a column to apply the filter to. The Column field
lists every column included in the SQL view. The column selected does not
have to be one of the columns displayed on the Data View tab.

3 At the Operator field, select the operator to use to compare the data in the
column to the value entered at the Value field. For operators that require an
upper and lower value, a second value can be entered.

Note: You can also create Boolean searches by selecting And or Or at the
And/Or field to join multiple filters.
At the Value field, enter a value to search on.

Click the Refresh button on the Analyzer toolbar to display the filtered data set
in the data view, pivot table, or chart.

Note: You can clear a filter by clicking the Clear Filter button. This removes
any filters entered regardless if they are either saved or unsaved.
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More information

For more information, see the Help system.

Using the Data View Grid

Overview

Use the Data View tab in Business Insights Analyzer to view the current data set for
an Analyzer task in a grid format. The data view grid allows for grouping and
summarization of any column by sum, average, count, minimum, or maximum.
Rows of data can be selected and copied to the Windows Clipboard.

Example

The following illustration shows the data view grid for the Sales History Analyzer
task.

= Sales History Analyzer
File Edit Yiew Tools Help

e E- B RIEE e @ E R @ -G E G 0 seting/sends

Cperator

Custamer Class Mame Custormer Mame Praduct Line Item Class Mame Cust Svc Rep Item Cost of Sales Amount
South ‘West Territary Business Insights Dashboard | Computer Spstems Hardware 1.44 Flappy 44.80( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 28.8 Modem 10.00( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 28.8 Modem 40.00( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 2wap Radio B4.60( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 2wap Radio 218.40| F
South ‘West Territary Business Insights Dashboard | Computer Spstems Hardware Graphic Station 440.80| &
South ‘West Territary Business Insights Dashboard | Computer Spstems Hardware Graphic Station 1,763.20| &
South ‘West Territary Business Insights Dashboard | Computer Spstems Hardware 1.44 Flappy 5.60| F
South ‘West Territary Business Insights Dashboard | Computer Spstems Hardware 1.44 Flappy 22.40( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 104100 Adapt 48.91( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 104100 Adapt 195.62| F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 28.8 Modem 30.00( F
South ‘West Territary Business Insights Dashboard | Peripheral Hardware/Companents Hardware 28.8 Modem 120.00|

(= dmin | 2~
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Creating a Pivot Table

Overview

Use the Pivot Table tab in Business Insights Analyzer to create a pivot table based on
the data set for an Analyzer task. This tab contains the Pivot Table control from the
Microsoft® Office Web® component, providing you with ways to dynamically
display and organize data from a field list, display filtered data from the data set,
customize summary and report total options, and export the data to Microsoft®
Excel®. Click the Field List button to select and drag fields from the PivotTable Field
List dialog box to columns within the pivot table.

Note: If Use Pivot Table as Chart Data Source is selected from the Business
Insights Analyzer Tools menu > Options Menu, data displays based on
changes to the chart. Likewise, changes made to the chart affect the pivot
table (such as changes to data and axes).

Example

The following illustration shows the pivot table view of the Sales History Analyzer
task.

== Sales History Analyzen Q@E|
Fle Edit View Tools Help
€T EIE-EIWmEE-Ee @z E M #E &6 E 5 st stndrd v
sl i I | 2@
Years v | Quarters
2007 2008
Ship To Country ~ Ship To State v Ship To City v |Ship To Postal Code ~ Net Sales Sum of Prafit Profit Pent Met Sales Surn of
B CAN BC 3 §1,006,250.26 $55¢
ac 3 $796,995.00 $20¢
Total 3 $2,793,.254.20 $76(
BUSA CA *O§77843.22804 $19295 31279 24.79% $323531,119.74 $138 600
co 3 $20,783505.64 4365
GA o $4186,174.77 $954,14009  2279% §6,127,p562.48  §1 360
WY 3 $3,527,084.40  §1.139
PA 3 $31,711,207.00  §6.69¢
Total * $6202040282 $20250052.89  24.69% $385740659.26 §152,19(
Grand Total 3 $6202040282 $20250052.80  24.69% $380533.913.54 §152.95
< >
{5 dmin | 2
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More information

For more information, see the Help system.

Creating a Chart

Overview

Use the Chart tab in Business Insights Analyzer to create a chart based on the data set
for an Analyzer task. This tab contains a chart control from the Microsoft® Office
Web® component, providing you with ways to view and organize data from a field
list, display filtered data from the data set, and customize the format of the chart.

Note: If Use Pivot Table as Chart Data Source is selected from the Business
Insights Analyzer Tools menu > Options Menu, data displays based on
changes to the pivot table. Likewise, changes made to the pivot table affect
the chart (such as measures and dimensions).

Example

The following illustration shows the chart view of the Sales History Analyzer task.

== Sales History Analyzer

File Edit View Tools Help

DETEIE-EDBIEE 7EE MG EDE R e
CIMNEEEETERIEEE EEETET )

2007 - Qtrl - Jan
2007 - Otrl - Feb
02007 - Otrl - har
2007 - Oned - Apr
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Using the Business Insights Explorer

Purpose

Business Insights Explorer allows you to navigate through data, preview and drill
down into related data for the selected data row, and customize and save filter
settings for future use. You can also use the Business Insights Explorer to perform
the following functions:

¢ Display the data set in a Data View grid.

e Refine and save customized data sets using filter tools.

e Save multiple settings for each Explorer data view.

e Add columns to or remove columns from the Explorer data view.

e Group or subtotal data directly in the Data View grid.

e Print the Data View grid information.

e DPort the data in the Data View grid to Business Insights Reporter.

e Export the data to Microsoft® Exce1®, Microsoft® Word®, PDF, or the eXtensible
Markup Language (XML) formats.

Accessing the Business Insights Explorer

Overview

There are three ways to access Business Insights Explorer, depending on your
workflow needs. You can also access a Business Insights Explorer task directly from a
window in the software or from the Tasks pane located on the Desktop.

Note: Many inquiry tasks have been replaced by Business Insights Explorer.
For more information on the inquiry tasks that have been replaced with
Business Insights Explorer, see Business Insights Explorer FAQs in the Help
system.
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Procedure

To access Business Insights Explorer from the software:

1

In any window in the software, right-click the field that has the Business
Insights Explorer feature available.

On the right-click menu, select Explore, or select Drill Into, select a data set,
and then select the filter setting name.

Note: If no customized filter settings have been saved, Standard is the only
filter that displays.

The Business Insights Explorer window appears with the selected data set and
filter in view.

To access Business Insights Explorer from the Business Insights task group in the
Desktop:

In the Desktop, on the Tasks pane, click the Business Insights task group.
In the Business Insights folder, expand the Explore folder.

Double-click an Explore task. The Business Insights Explorer window appears
with the data set for the selected task in view.

To access Business Insights Explorer from a module task group in the Desktop:

1

In the Desktop, on the Tasks pane, click the task group for any module that has
the Business Insights Explorer feature available.

In the module folder, expand the Insights folder.
In the Insights folder, expand the Explore folder.

Double-click an Explore task. The Business Insights Explorer window appears
with the data set for the selected task in view.
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Example

The illustration below shows the Data View grid for the Explore Customer task.

== Explore - Customers

File Edit View Preview DrllInto Analyze Manage Insights Took Window Help

BE-EIhB EWE M GG DEE I snafsang v

= preview

@ Open Huotes

Cust Customer Credt Linit Balance | Highest Bal | Highest Bal Date | Avg Days Past Due | Ava Days To Pr

Open Orders Eldebaran, Inc. 000000000|  BO.3B935| 14316137.94] 3172008 655 38
Opennvoices Blicia Gaage Doors 00| 22537646 Z0B07HAE3| 172008 547 E,
Open Aibbs Business Insights Dashboard 100,000.00[ 94405121 66| 94.40641566] 6/30/2008 [ q
Open Projects Blackwell Emulsion Co. 00| 11202375 20372450 172008 1828 6
Open fork Orders Campbell Electiic 75,000.00 o1 838,381 za‘ 37172008 595 230
Recent Payment;
cen Paymens Calier & Sans. Inc 00]  ee0343] 6503143 6/12/2008
Unapplied Payments
o aienes Compuler Repai and Sdes [ 53500 29601239 3172008
T Compound S olutions 00| 298628376 808755164  &1/2008 763 Bl
astactiviy Complete Tax Servioes 75,000.00 00[ 17465238  3/1/2008 35.25]
©) Saved Credit Cards Tonsolidated Blders 5 upples 00,000.00 [ 00| 3172008 [

) Credit Card Transactions

o Analyze

Wi Manage

More information

For more information, see the Help system.
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Using the Business Insights
Dashboard

Purpose

Business Insights Dashboard includes a series of key business data components (also
referred to as Web Parts) that generate summary information and charts from your
financial information. These components appear in the user’s Web browser and can
be customized. This Web site provides executives with the ability to view and
customize key business data for a selected company. You can also use the Dashboard
Web site to view Business Insights Explorer data, as well as set links to commonly
used sites.

Business Insights Dashboard requires ASP.NET and AJAX extensions, both of which
are installed automatically if your system currently does not have these installed.

Business Insights Dashboard requires Windows authentication and cannot be
configured for anonymous access. To access the Business Insights Dashboard, a
system administrator needs to set up the Web site for executive access. For more
information, refer to the Installation and System Configuration Guide.

To learn more about using the Business Insights Dashboard, access the Business
Insights Dashboard tutorials by clicking Tutorials on the Sage 500 ERP Desktop Home
pane.

Accessing the Business Insights Dashboard

Procedure

To access Business Insights Dashboard:

1 Open a Web browser window.

2 At the Address field, type the Web address for the Business Insights Dashboard.
For example, http://www.mycompany.com/BusinessInsightsDashboard
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The illustration below displays the Business Insights Dashboard:
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More information

For more information, refer to the Business Insights Dashboard Guide.
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Batch Processing

You can process transactions in batches. The Batch Processing
feature allows multiple users to enter transactions at the same
time using unique batch numbers. One batch can contain either a
single transaction or hundreds of transactions.

One advantage to batch processing is the ability to print the
registers, review the reports, and make corrections before
updating the modules.

This chapter describes how to set up batches, enter batch
information, and the options for posting.

In this chapter

Setting Up Batch Options. . ............. ... ... ..., 106
Entering Batch Information......................... 107
Posting Batches. ... ... ... ... . . . . L. 111
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Setting Up Batch Options

Setup options

You can select various batch-related settings in your module's setup options task. For
example:

e Allow the creation of private batches, which limits access to a batch.

e Enter batch override segments for general ledger accounts.
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Entering Batch Information

Purpose

Use batch entry windows to create batches, enter additional data in existing batches,
print batch registers, and post batches. For example, Accounts Payable has the
following batch processing tasks:

Process Vouchers, where you enter invoice, credit memo, and debit memo
information.

Process Invoices for Payment, where you select which invoices to pay and print
the checks for these invoices.

Process Manual Checks, where you record information for checks that you
wrote manually. You can also print manual checks using the Quick Print
feature.

Apply Payments and Memos, where you apply previously posted unapplied
payments, credit memos, and debit memos to open vouchers or memos.

Post AP Batches, where you can select, print, and post multiple batches. This
task also gives you an overview of the status and totals of all unposted batches
in your payables system.

Process Settlements, where you generate and enter settlements of Accounts
Payable vouchers and Accounts Receivable invoices, print settlement reports,
and post registers.

A batch entry window appears when you select these tasks.
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Batch Processing

To enter information, create or reopen a batch in a batch entry window; this is the
first window that appears in a batch processing task. You can then enter information
for individual transactions. For example, you might enter 20 invoices in Accounts
Payable Process Vouchers. When you exit the data entry window, the batch entry

window appears again so that you can verify batch totals.

=¥ Process Vouchers

va @ex B @ @B

Batch | % Desc [March 38 Status:  Balanced
r Posting Date |06/21/2020 - m

[ OnHaold Hold Reason

Begister/Post...
Diepartment % —}

Tran Type | Count Arnount
Control Armt $0.00 m | Sl 4355563
Batch Total $49,5568.63
weoee v adrin [50A [5/5/2020 [Z

Batch control amounts

The batch control amount must equal the total of all transactions in the batch. If the
batch total is negative, due to debit memos, the batch control amount must also be
negative. If the batch is out of balance, the variance amount is displayed in the batch

entry window and restricts posting.

Tip: You can optionally enter a control amount to double-check data entry

totals to a separate adding machine tape result.
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Unposted batch statuses

For each batch, the current status of the batch appears in the batch entry window.
The status for any unposted batch can be one of the following:

In Use

> Indicates another user is currently accessing the batch.

> Assoon as you generate or begin to work in a batch, its status
automatically changes to In Use.

> Additional users can still open the batch, unless it is marked as private.

On Hold

» Indicates a user selected the Hold check box in the batch entry window for
the batch.

»  You cannot post a batch that is on hold.

Out of Balance

» Indicates financial amounts in the batch are not in balance with the
control amount.

>  You must correct the balance before you can post the batch.

> An Out of Balance status applies only if you enter an amount in the
Control Amt field on the batch entry window.

Balanced

> Indicates transactions in the batch are in balance, and the batch is not in
use.

Posting

> Indicates the batch is currently being posted. This status displays only
during posting.

> After posting, the batch no longer appears in the list in the batch entry
window.
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* Interrupted

> Indicates that during the posting process, an unrecoverable error occurred
(for example, a power failure).

> No general ledger account balances are updated on an interrupted batch.

Getting Started 110



Batch Processing

Posting Batches

Purpose

The batch posting process summarizes and applies batch amounts to specified
general ledger accounts. You can post a single batch in a batch entry window, such
as Process Vouchers, or post multiple batches using a Post Batches window, such as
Post AP Batches. When you are ready to post multiple batches, you can sort batch
information by batch number or posting date by clicking the applicable column; or
you can display only those batches with a status of Balanced.

Note: Only balanced batches can be posted.

Verifying batch information

Before posting batches, verify batch information in one of the following ways:

* Review totals information in the batch entry window.

e DPrint the register for the task and review it.

You can then make corrections, print, and review the register before beginning the
actual posting.

== Ppst AP Batches g@@

FIECE

Show Only Balanced Batches v
Pririt Fost Proc Status Batch Post Date Status Created By | Priv =
I r APMC-0000001 03/20/2008 Balanced admin I
r r APPA-0000001 06/04/2008  |Balanced sufreder I
r r APSC-0000033 06/05/2008 Balanced admin r
r r AFY0-0000078 06/22/2008 Balanced admin I
I~ r APY0-0000031 06/12/2008  |Balanced klkarls r
I r APY0-0000094 06/30/2008 Balanced admin I
r r APYV0-00038 06/21/2008  |Balanced keratif I
r r APY0-00064 06/16/2008 Balanced kcratlif r

1 v[ ]
admin (504 | 6/6/2020 IE Y
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Posting options

When you click Register/Post in a batch processing task, a window similar to the
following appears. Use this task to select additional options, such as the number of
registers to print and register format.

The following printing and posting options are also available:

¢ Print and then post

e Print and then prompt for post
e Print and do not post

e Preview only

e Post only

== Register/Post [Batch: APY0-00036] =3

r G e DB

Beport Destination |Network Printer - Properties..
. . = Register Options

Copies to Print 1 - N .

=oP — " Print, then Past " Preview Only

+ Print, then Promet for Past
Fieqgister Format Summary - " Print, Do Mot Post

r

Report Meszage |

| m’a £/5/2020 @

Posting to a future period

To post transactions to a future accounting period, enter the future period date as
the posting date in the batch entry window.

The posting date is used to post transactions and check them against the current
period, which is defined in the module's setup options.

Getting Started 112



Batch Processing

Posting to a closed period

To post to a closed fiscal period, you must reopen the period in both General Ledger
and the module from which you are posting.

Overriding account number segments

You may want to track certain expenses by department or region—assuming your
general ledger account structure includes validated segments for these categories.
However your general ledger account is structured, the concept is the same. The
batch override option gives you the flexibility to easily track and report
departmental or similar subcategories of expenses.

Note: You cannot select the same override segment for vendor class and
batch.

If, for example, you are tracking departmental expenses, in Set Up AP Options, you
define the override option for the department segment of the general ledger account.
When you subsequently enter invoices, you can select the department from a
Lookup window in the batch entry window. The department code then overrides the
default account segment for all transactions in the batch.

Additional information

For additional information on account segment overrides, see the Help system.

Invalid accounts

The system handles amounts for invalid accounts in the following ways:

e Invalid accounts are detected during data entry. Accounts are also verified
during pre-posting processing. You cannot post a batch with invalid general
ledger account information.

e If you have enabled a batch or class override for a general ledger account
number segment, and you have enabled the allow addition of new accounts
feature, a new account number can be created. If the override fails, you receive
a warning, and the system reverts to the original account.
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* Invalid accounts are noted in the printed error log. You can either create an
additional account in Common Information Maintain Accounts, or correct the
voucher or check information with the correct account.
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Generating Reports

Sage 500 ERP includes sophisticated reporting capabilities that

allow you to produce numerous reports and lists. Reporting

features can assist you in managing and planning your business.
This chapter describes the different report types and features, and

indicates how to print, preview, defer, and customize Sage 500

ERP reports.

In this chapter

Reporting Features . .............. ... ... ... ... ... 116
Report Types. ... .. 117
Standard Report Elements .......................... 119
Generating Reportsand Lists . .. .......... ... ... .... 121
Previewing Reports.......... ... ... ... ... ... 124
Deferred Printing .. ......... ... i 126
Customizing Reports ........ ... ... ... L. 128
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Reporting Features

Purpose

Sage 500 ERP reporting features enable you to:

Specify the content and format of reports.
Preview a report on screen before printing a hard copy or sending it to a file.
Defer reports to a print queue to print at a later time.

Define multiple report settings for the same report, and save each under a
different name. This allows you to create several versions of the same report
and to quickly and routinely print them.

Save report settings for future use.

Print lists containing data and system settings from many of the maintenance
tasks.

Change report fonts, colors, and other format features within Sage 500 ERP.

Create and customize reports and forms using Crystal Reports for Sage 500 ERP.

Supported printers

Sage 500 ERP supports only laser printers. You cannot use dot-matrix or ink-jet
printers to print Sage 500 ERP reports.
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Report Types

Purpose

Reports provide you with reference information, transaction records, and a variety
of analytical assessment tools. There are four report types:

e Reference reports (lists)
e Audit reports
* Analysis reports

* Financial activity reports

Reference reports (lists)

Reference information is available in lists that include system settings and
enumerations of data groups. Lists allow you to verify the organization of the system
and review data in the database. Lists are accessed primarily by clicking the Print
button in maintenance tasks. The System Manager User List is an example of a
reference report.

Audit reports

As you add, change, or delete records, Sage 500 ERP stores this information. Registers
are preposting reports that allow you to verify transactions before you post them.
Most registers can be viewed in summary or detail form. You can also generate
reports to check information on posted transaction activity.

Analysis reports

Analysis reports help you analyze activity that occurs within the system, such as
aging and statistical summaries and comparisons or current and closed accounting
periods. The System Manager System Activity Log is an example of an analysis
report.
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Financial activity reports

Financial reports provide a picture of financial activity over a selected period of time
and your current standing. These reports allow you to review expense totals and
outstanding invoices, plan for future cash needs, and track information required for
governmental reporting.
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Standard Report Elements

Report elements

Reports are preformatted to include the following standard elements.

Report section
content

Data included

Page Header
Company bar

Report title
Report subtitle
Report message
field (optional)

Report Body
Report Summary
User ID

Selection criteria
Sort criteria

Page Footer
Run date/time

Business date

Company name

General report title

Specific report title

User-entered description of sort
and/or selection criteria (if any) for
report data (optional)

All report data

The person who generated the report
Conditions for data selection

Key fields designated for ordering data
(last page of the report—not shown)

Date and time derived from the
operating environment

Date derived from System Manager

You can change the appearance of these elements as shown in Changing Report

Formats on page 128.

Report detail

The Help system provides module-specific report explanations and samples.
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Example report

Following is a Sage 500 ERP report sample.

Header:
Company Name
Report Title/Subtitle

Report Body ——

Footer:
Run/Business Dates

Generating Reports

Report Message

Purchase Order
Options List

Systems of Americal

This is where your text would be if you typed a

message in the Message text box for a summary
or detailed list.

Current AP Fiseal Period

Current AP Fiscal Year

Allow Private Batch

Warn for Duplicate Purchases

Print Purchase Orders

Track Deleted Purchase Orders
Default Cost at Purchase Order Entry
Use Same PO Num for Blankets

Use Blanket Release Num

P

ting

Post GL Transactions Yes
Posting Register Format Detail
Accounts

Drop Ship

Purchases Clearing
Purchase Price Variance

4015-00-00-00
2001-00-00-00
4570-00-00-00

Account Override Segments
Vendor Class

Activate Change Order Processing Batch Department
Check Vendor Credit Limit Department
Integrate with AP
Inteorate With IM Post in Detail
Track Sales Tax on Purchases Accounts/Payable Yes
Freight Charges Yes
Invoicing Purchases/Expenses Yes
Invoice Complete Yes  Sales Tax Yes
Blind Invoicing No  Discount Earned/Lost Yes
Purchase Price Variance No
Data Retention Purchases Clearing No
Purchase Orders 24 Months
Requisitions 24 Months  Apply Dept Override
Revr Retnt 24 Months  Freight Charges No
Purchases/Expenses No
Matching Sales Tax No
Match Receipts to PO Yes
Match Invoices to PO Yes  Apply Class Override
Purchase Order Default five  Freight Charges No
Purchase Order Line Item Default five  Purchases/Expenses No
Sales Tax No
Control Characters
Change Orders C Apply Bach Override
Release Num R Freight Charges Yes
Purchases/Expenses Yes
Receiving Sales Tax Yes
Close Entire PO on First Receipt No  Discount Earned/Lost Yes
Close PO Line on First Receipt Yes
Receive Complete Yes  Default Receiving Address
Default Receipt Days Early 0 Systems of America
Blind R Off 165 Pacific Highway
Receiving Ticket Method Expected ltems  Malibu, CA 90263
Receiver Item Volume Update (none)
Receiver Item Weight Update (none)
Run Date: 612020 11:43:59 AM Page 1
Business Date: 6/5/2020
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Generating Reports and Lists

Overview

Each module provides a Reports menu that contains that module's report options.
Additional lists can be generated from within tasks on the Maintenance menu.

Common printing options

Task report windows display common printing options, which are shown in the
following example.

Deferred Print
Select to print the report

Save report settings settings on the last page
Preview for future use. of the report.

cRL EX @ D

The IDs of report— zating
settings that you save
appear at this field.

Print

|I:urrent Options j [~ Print Beport Settings

Sort and selection criteria
Most report setup windows have two tabs that are used to specify sort and selection
criteria:

e Main

* Options

The selection criteria and sort order define the information that appears on the
report.
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Multiple print settings

You can define several print settings for the same report and save each setting with a
different name. This allows you to create several versions of the same report that can
be printed quickly.

Using the Main tab

The Main tab is used to define the sort and selection criteria for the report. Multiple
sort and selection criteria can be defined on one report.

The available information depends on the type of report you are printing. For
example, Accounts Receivable reports include sort options for customers and
customer classes.

Columns determine the = fged Receivables EoX
order of items on the cR&EX O @
report, if subtotals are SetingiNone) =] I Fin Bt Setinge
added, and where to o Mol
Gor
insert page breaks. Field Sort Order Subletal Page Break 1=
r r
r r |
r r
r r
Determines the records L - =
Select
that appear on the report, _ Fod BT B
such as Is equal to, Is natum
Bill Ta Customer Addiess Al -
greater than, and All. o on o
Commission Payment Method | All
Credit Limit Al
Customer Class Name Al
. . . Cuist Al
Right-click a field and Cortms i

select Insert Line for
additional selection criteria.

[smin [s0a | /572020 [ =

Note: To speed up searches, use the "Is equal to" or the "Begins with" filter
type instead of the "Contains" option.

Using the Options tab

The Options tab is used to determine the overall report format and is generally
report-specific. Available options vary, depending on the type of report.

Note: Not all reports have an Options tab.
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Examples of options include:

e Detail or summary format
¢ Date criteria
* Message field contents
== pped Receivables

SE2L X @D

Setting | (None) =] [~ Print Beport Settings

Man | Options

Eomat

£ Customer Summary
& Invoice Summary
£ Inwoice Detal

Options Include
AgedsOiDate  [05/30/2008 = I Apploation Detail
Age Based On Invaice Date hd [~ Invoices Closed in Current Period

Inclusion Date Dated OnorBefore = [~ Fulure Applcations

AgngCategory  [Al = B

Disputed Inwaices [

Message

Messages entered
here print in the
header of the report.

Jactin |04 | 6/5/2020 |5
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Generating Reports

Purpose

Export

Print

Search for specific
information in a report or list.

Use the Preview feature to display a report on your screen. If the report does not
require modification, you can either send the report to a printer, export it in your
choice of file formats, or e-mail it to another user.

Items in the Group —
Tree window reflect
sort options with the
Subtotal check box
selected on the Main
tab in the report
setup window. The
Group Tree window
can also contain
additional system-
defined levels.

== Venclor Payment Activity 1)

&G & #F %=l -

Accounts Payable
Vendor Pavment Activitv-Summarv

~

Batch: APMC-0000003

Batch: APMC-0000003

Batch: APSC-0000018

Batch: APSC-0000018

Batch: APSC-0000019

Batch: APSC-0000018 v

Preview features

Additional preview features:

Top Hat Productions

§mart Offics Solutions

§mart Offics Solutions

b

Using the toolbar at the top of the preview window, scroll through the report

pages and change the view magnification.

Export in several formats, including Text, Crystal Reports, Excel, and Microsoft

Word.
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Export information to a file or an e-mail message.
Group Tree window information can be grouped by subtotaled sort options.

As you select items in the Group Tree window, the corresponding information
displays automatically in the Preview window.
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Deferred Printing

Overview

You can postpone printing a report and store it as a file to print at a later time. The
Deferred Printing task in the System Manager Tools menu is then used to select and
print the stored report. This feature allows you to create multiple reports from
various modules and print them all at the same time.

Deferring a report

1

Select the appropriate printer for the report you want to defer. (The destination
printer cannot be changed when printing the report in System Manager
Deferred Printing.)

Click the Defer button on the report setup window. The Create Deferred Print
File window appears.

Create Deferred Print File @@
Saven | ) Fage MAS 500 - £F BB
Y =730
My Frecent
Documents
/ﬂ%
Deskiop
My Documents
—
s
My Computer
s
Myprlletwum File name: vendor Papment Activits APT =l Save
lsces
Save as ype: | Crystal Freports =] Cancel

Enter a file name, or accept the file name that automatically defaults to the
report name.

Click Save to create the file. The report is automatically saved in Crystal
Reports file format and cannot be changed.

Close the report setup window.
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Printing a deferred report

Select System Manager Tools menu > Deferred Printing. The Deferred Printing
window appears, which includes:

The module from which the report originated
Title, date, and time deferred
User ID

Destination printer

=¥ Deferred Printing Q@El

SB (X cled
Lompany m
Module Title Copies  Purge? Path ta File Defer Date” =
1 [P0 JPuchase Dider Status | 1| I |c\Documents and Seftings\dministrator] 2005-06-14 10:28
2 [BF |Vendor PaymentActivity | 1| T |E\Documents and Settings\clgonzal\Apy] 20030505 03:10
Only the Copies
and Purge
columns can be
changed on this ; : o
window. lﬁ@ ez |5,

To automatically delete the report after printing, select the Purge check box;
otherwise, the report remains in the Deferred Printing window until you delete
it manually.

Enter the number of copies to print.

Click the Print button to print the report, or click the Preview button to
preview the report.
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Customizing Reports

Overview

You can customize reports using Maintain Report Formats in the System Manager
module.

Changing Report Formats

Overview

You can change format features of reports. These include changing the font, content,
and format of headers and footers. Format changes can be applied to all companies
within a database, or different formats can be used for individual companies. The
format changes you make will apply to all reports for a company regardless of who
generates the report.
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Using the Maintain Report Format form

Select System Manager Maintenance menu > Maintain Report Format. The Maintain
Report Format window appears.

=€ Maintain Report Format El
HEd X @ e
Comnpany |[AH] ﬂ
[ Msglines | RepoBody | Footer | Loao
Compan Module Tile Subiills
pany | [ I Module
Company Bar §
Print Color Title
@ Default © Yes © Mo | Dottt [l | Subtitle
ez e 1
E'o:mplany Mame Mezzags Line 2
il
@ Default " Yes ¢ Mo Caption
Customer Seles COGS  Profit
Alignment Ahciety 33333 M1 88888
 Defaut ¢ Left ¢ Center (" Right Abedefy 993.99 M1 gEsEs
— Ahctiety 999.99 M1 BEeEs
Abcdely 99383 M1 S8EEs
@ Defaut " Name €D " Both Ahcdefy 999.99 M sEeEs
Font
Name [(Defaul) x| size[iDefau) =]
Color
W Defaut [ ]
Bold
& Defaul (" Yes C No
Sradize
@ Defaut (" Yes © No
Underling R Dt SEATE 21445 AN
 Defauk " Yes £ Mo B¥eies DGO rage 1
admin |50 | /572020 B

Use the tabs on the left to set the format of a section of a report. You can also click a
section of the preview to switch to the appropriate tab. Changes you make to the
format appear in the preview.

When you have completed changing report formats, click the Save button. The
changes appear the next time you run a report.

Note: If a report is open or in progress when you change the report format,
you can apply the format changes by rerunning the report.

Companies and format changes

The Company field enables you to apply changes to all companies or individual
companies.

If you select a company in the Company field, the format changes apply only to that
company. You can make different settings for each company.
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If you select (All), the format changes you make become the default for all
companies. You can still make settings for individual companies.

For example, if you wanted the text for the company bar to be centered and have a
caption of "Company: " and each company to have a different colored company bar,
do the following:

e For (All), set the alignment to center and type "Company: " as the caption.

e For each company, set the company bar color.

Default settings

The Default setting for each option enables you to revert the format as follows:

e For a company, Default reverts to the format of (All), if a custom setting was
made. If there is no custom setting, the format in the report definition is used.

e For (All), Default reverts to the format in the report definition.

Fonts

Sage 500 ERP reports use the fonts on a user's workstation. When you select fonts for
a report, select a font that all users have. If you select a font that is not on a user's
workstation, Arial is substituted for it.

Clearing format changes

To clear all the formats for a company, click Delete. You are prompted to confirm the
deletion.

If you select (All) and click Delete, the settings are cleared as defaults for all
companies. If you set up settings that are specific for a company, they are not
cleared. To use the previous example, clearing (All) resets the alignment and caption
to the format in the report definition, but keeps the company bar color settings you
made for each company.
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Designing Reports with Crystal Reports

Overview

Sage 500 ERP comes with the powerful report generator, Crystal Reports, which
includes templates that allow you to produce professional reports.

Features
Crystal Reports has the following features:
e Use a predefined report template or design your own template.

¢ Include information from one database or from several data sources, do
extensive calculations, and merge text with data.

* Produce mailing labels and form letters that draw from your data sources.

* Modify Sage 500 ERP reports, lists, and analyses.

Crystal Reports documentation

Crystal Reports for Sage 500 ERP comes with documentation that guides you through
its installation. For instructions on using Crystal Reports to redesign report
templates, refer to Crystal Reports' documentation and the Help system.
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Using the Help System

The Sage 500 ERP Help system provides information and
assistance in all aspects of the software, including system basics,
step-by-step instructions for individual tasks, and field-specific
help. The Help also includes module PDFs that describe the tasks
you can access from the Desktop.

In this chapter

Typesof Help ... ..o 133
HelpCenter........ ... . . 137
Viewing the Contents Tab . ...................... ... 139
Viewing and Printing the Module PDFs. .. ............. 140
Viewing theIndexTab............... .. ... ...... ... 141
Understanding a Help Topic. . ......... ... ... .. 142
Usingthe Tutorial. . ........... ... . .. ... ... .. ... 143
Quick Reference . ........ ... .. 145
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Types of Help

Introduction

The Help system includes the following types of Help:

* Overview Help
e Procedure (How Do I...) Help
e F1 Field-Level Help

Overview Help

Overview

The Overview Help provides a functional overview of each task. Links to procedures
and related topics are also provided in Overview Help.
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Accessing

To access Overview Help, click the Help button (or press CTRL+H) from

any task
window.

¥ Frint Beport Setiings

E? Help Center

<
Field Sort O Show Back Print Sage
User [Ascending 7
User List
Window Details
EEE: > Navigation
Fild Condt] 5 Oeryion
User E]
»
User Narme & Fields
How Do ...
> Print a Repott or List > Defer a Report or List
> Proview a Report or List > Piint a Deferred Report or List
Related Topics
>Maintain Users > System Stalus
> Maintain Security Groups > Sattings

Access this window using one of the following methods

« Select System Manager Reports menu » Other Lists » User List

« Select System Manager Maintenance menu > Maintain Users. In the Maintain
Users window, click the Print button

Overview =

Use User List to produce a list that shows user codes, user names, and the security

groups that have been established for the users. You can set up users in Maintain

Users and security groups in Maintain Security Groups

Fields =
Setting Print Report Settings

Main

Field (Sort Condition

Procedure Help

Purpose

Procedure Help provides step-by-step instructions for completing a specific task.
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Accessing

Access Procedure Help from the How Do I... links in the overview topic.

E? Help Center g
¢ & [

Show Back t Sage

Change Security Groups

Home | FAQ Troubleshooting

Click a Shortcut button

to open the task. This To change s““”f\’ groups

allows you to complete 1. Click here i to start Maintain Security Groups.

a task while foIIowing 2. Inthe Maintain Security Groups window, at the Security Group field,
_hv- enter the security group to change. For more information, see Maintain

the Step by Step Security Groups - Fields

instructions in the

Procedure Help 4. For each task, at the Permission field, select the appropriate setting
window. for this security group. To apply the default permission setting, select
the setting at the Default Permission field and then click Apply.

3. At the Module 1D field, select the module to change.

5. Click the Security Events tab. For each security event, at the
Permission field, select the appropriate setting for this security group
To apply the default permission setting, selecting the setting at the
Default Permission field and then click Apply.

Note Security Events are available only for some modules.
6. Click Finish.

F1 Field-Level Help

Purpose

F1 Field-Level Help provides information that is specific to a selected field, button, or
tab.
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Accessing

Access field-level Help by pressing F1 at each field or by right-clicking and selecting
What's This?.

Example

The following window shows an example of F1 Field-Level Help for the Status field.

= Maintain Salespersons E”§|E|
vdoX 2&o 80 D RR
Salesperson | E |dohn Smith
Address

Status Aclive - Shest Addr
Sales Manager EZ Help Center

Commission Plan JSHJ = @
Carm Prot Method | Manual Show Back Print Sage
~
Vendor Status A
To set the cument status of a salesperson, select
User ID
« Active to include the salesperson in all normal processing and to enable

the salesperson to have access to eSalesforce. Primary members of a
Custam Fields sales team must be set to active status

15541 5. Greerwiew Ave.

Inactive to exclude a salesperson when invoices or customers are entered
(they can be paid a commission on existing posted invoices). Inactive
salespersons cannot be selected during invoice entry or assigned to new
customers; however, they are eligible for commission payments on existing
posted invoices. Inactive salespersons remain in the system until you
purge them

Wl a| v

Deleted to bypass a salesperson during processing, but retain thern in the
software until history is purged.
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Help Center

Introduction

The Help Center provides links to the documents, Help system, online resources,

and technical support information available.

Ways to access
Access the Help Center three ways:

On the Desktop, select Help menu > Help Center
Click the Help Center link on the Desktop Resources page

Click the Help Center button on the docked Desktop toolbar

Content

The Help Center provides access to the following sources of information:

Installation guide

Help system

Reference information, including sample reports
Module PDFs

Technical support
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Example

The following window shows the Help Center options.

4 Help Center o
He&l

Sage 500 ERP Help System
@ wielcome

@ Navigating Thiough the Software
@ Using the Sage 500 ERP Deskiop
@ Fiinting Reports and Lists

@ References

@ Using the Help System

g mg:::: :[E)‘ES Click the corresponding buttons to access the Help, FAQs, and Sage Support
@ Technical Suppart Resources

Resources
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Viewing the Contents Tab

Purpose

Use the Contents Tab to access the table of contents for the Help system. The
following illustration explains the common features of the Contents tab.

== ==

When youfirst — g« 5 5

peoessliel | sagestoERPHepSysem
the Contents
tab is hidden.
Click Show to

use the Engﬁzgowespmm buttons to access the Help, FAQs, and Sage Support
Contents tab.

@ Navigating Thiough the Software
@ Using the 5 age 500 ERF Desklop
@ Piinting Reports and Lists

@ References
@ Using the Help System
] g”d;‘e H Cllick the cotresponding buttons to access the Help, FAQs, and Sage Support
& oot Resources

@ Data \mp:x Marager
([ General Ledger

([ General Ledger
The Contents tab Qllgum Started with Genel
displays Help
topics organized

by key subjects.

i Enable Intercomps
- [2) SetUp Data Rete!
[2] Set Up the Cunen
@ Importing Data
@ Exporting Data
@ working with
@ Piinting Reparts and Lists
@ Flowcharts
@ Muliicurrenc, -y
@ Poject Accounting
@ Purchase Order L4
@ Sales Order
@ Sage 500 ERF Office
. borul PDFs
il —

Resources
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Viewing and Printing the Module PDFs

Purpose

You can view and print PDF documents from the Help system that contain task
information for each module. Use the links located under the Module PDFs book on
the Contents tab to access and print the PDF files for all modules.

Accessing

Use the links located under the Module PDFs book on the Contents tab to access and
print the PDF files for all modules.

E? Help Center

i & & 9

Hide Back Fint Sage

Contents [Ipdex | Search

EE&

BE e e Ny § o0

@ welcome

@ Navigating Thiough the Software
@ Using the Sage ERF MAS 500 Deskiop
@ Piinting Reports and Lists
@ Feferences

@ Using the Help System
@ Hodule Help

(7] Module PDFs

[2] Aecounts Papable

2] Accounts Receivable
7] Cash Management

[9] Camman Information
2] Credit Card

2] Customizer

7] DataImport Manager
[7] General Ledger

2] Inventory Management
2] Manufacturing

7] M&S 500 Dffice:

[2] Muticurrency

2] Product Configurator
2] Project Aecounting

[7] Purchase Order

[7] 34les Order

2] system Manager

@ Techrical Support

@wllaburatev Foo- H B [ |

‘Sales Order Overview Document

50 Setup

Set Up SO Options

Wingow Detalis How Do ...

¥ Naigation » S&Up tzm SuBsttuton I Pickng

» overview ¥ SetUp StarShip Integration

b Feios » Use DataPorter with Enter Sakes Grders and Guotes
Related Topics

¥ optans st » S8t up AR Optons

» wantenance Fowenarn » Assiste Company Sep.

/85 OIEr MantEnance Meny > SO Selp > St Up SO Options.

overvisw
sz 561 Ug 50 0; S35 OruEr Moduie Tory 9
requirements. You can select cred options and cred check feaiures. module Iniegraiion options,

processng optons, and prIAGNG ORYeNs, 31d 513D LSer-08fned Neids, batch, and iransactan
SSINGS. Y0 3N 3150 356N 101 10 USE 35 OETHUIE.
You ean also select the general ledger account fo use 36 drop-5ip, s3les Gearing, and
festocking charge aooounts. You can defermine whemer a general ledger account pverids
segment apples to a epecic ascount. The account segment overde defauts from Set Up AR
GpIans ana cannot be modMzd I tne S3les Ofder module.
You £an sslect sNpping and picking ptions, Enter drop-Ship Mo, 3d s8¢ U Integration
WIth 3n extemal SAIRNg System, Such 35 SIarSAIp.
You can establlsh data retention imits and 3 default warehouse. You ¢an alsa enter a character.
o signify a change order number and release number.
For customer retums, you can define defaults, set restictions, 3nd enter options. You can also
designate when and I Retum Material Autnorizations {RMAS) are fequires
MNoTE You ean also use Asslsted Company Selup to st ogtons for tls and all modules.
Fsios

850x11.00In ¢
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Viewing the Index Tab

Accessing

Use the Index Tab to search for specific words and phrases. Each Help topic has
keywords associated with it. You can search for a topic in the Index by entering
keywords. The following illustration explains the common features of the Index tab.

%4} Help Center

He &

Tupe in the kepward to find

B

import ertor messages
mport record kot Click the corresponding buttens to access the Help, FAQs, and Sage Support
overvizw

1099 Box Resources.

fields
overview
1099 Forms
fields
overview
setting up
1039
beginning balances. import error messag:
beginning balances. import record layout
beginning balances, importing
conecting data
ediing data
enteting vendor information
erton messages
excluding data from voucher
foms, setting up
impor enor messages
import record layout
sekting up forms
setting.up vendor classes
settinip vendors
vendor infarmation, erteting
access
assigning users (0 access levels
setting up access levels
Access Level List
fields
overview
sccess levels
assigring users
setting up

Resources

Display

| 3
|

Select a topic, and then click

Display to view the topic. Or,

double-click a topic in the list

box to view it.
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Understanding a Help Topic

Purpose

A Help topic may contain procedural information, overview information, or
information about a particular feature.

Click FAQs &
Troubleshooting

to view frequently & B
asked questions Show Back Prnt Sage
grouped in 5 , = —
categories, such ustomize a Form
as Budgets or Home | FAQs & Troubleshooting
Checks. Show/Hids Al
- Click the +/-
. . . Overview P
This section lists — = Before You Begin graphlc link to
items that must be Before you customize a form, make sure data is not being maintained. expand or
i collapse all

accomp“Shed To customize a form d naFr)nic dro
bgfore performlng 1. Open a task to customize. dzwn links inp
this p.rocedur(?, or 2. Press ALT + F3. The Customization window appears. this tOpiC
speC|aI conditions 3. With both windows open, select a control to modify. You can either '
that may affect the select a control on the form or at the Name field, select the control
result of this name

note To customnize a control on a tab not in view on the form you are
procedure. customizing, click the tab and then use the Tab Page arrows in the

Customization window to move from tab to tab.

Handles appear on the selected control. The Customization window

updates to display the name of the control you selected and displays

tab pages with the customizable attributes for the control type. =

4. Enter fields on the Properties, Color & Font. SOTA Mask Edit, SOTA

Mumber, and SOTA Currency tabs to customize the current control.

For more information, see Customization Control Properties - Fields.

Note For toolbar controls, only the Properties tab appears. The SOTA

Mask Edit. SOTA Number, and SOTA Currency tabs appear only for

the controls to which they apply.

5. To move a control, enter the Top and Left fields. To resize a control.

enter the Width and Height fields.

NOTE Use caution when moving standard controls to different tabs or

containers. The task may no longer function logically or properly after

this type of change has been made. v
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Using the Tutorial

Select Help > Tutorial to take a quick tour through the software. The tutorial is a
multimedia introduction to the software's basic concepts and features. Use it to
become familiar with basic concepts, such as navigating the software, customizing
your Desktop, and printing reports.

Note: You can also access the tutorial from the Desktop Tutorials page.
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Tutorial topics contain short movies that demonstrate visual tasks
in the software. To play the movie, click the Forward button. You
can stop and rewind the movie at any time. You can also click and
drag the bar that appears to the right of the Forward button to view
the movie forward or backward at your own pace.

Using the Help System
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Quick Reference

Using the Help System

Help features

The following table provides a quick reference to the Help system components and

features.
Graphic Component Located Description/How Accessed
- Overview Mostwindows On windows, provides a functional
G Help and and Desktop description of the task and links to
Help Center related information. For more

Sage 500
ERP task
shortcut

Task Help

5l

information, see Overview Help on
page 133.

On the Desktop, opens the Help Center.
For more information, see Help Center
on page 137.

Opens the Sage 500 ERP task, allowing
you to complete a task as you follow
the step-by-step instructions in the Task
window.
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Glossary

The glossary is applicable to all modules.

absolute
pricing

access
permissions

account

account
category

account group

account
number

Pricing based on a fixed dollar amount for each price level.

The right given to display, add, change, or delete information. You
give this right when you assign the user a password or assign the
user to a security group. Permissions include Excluded, Display
Only, Normal, and Supervisory for tasks, and Yes and No for
security events.

A type of record that contains business transactions affecting the
same item, such as a record containing all charges to Cash or
Telephone Expenses.

A group of accounts that are treated similarly for financial
reporting. The five basic account categories are assets, liabilities,
capital, revenues, and expenses.

A range of account numbers defined during account setup that
provides the basis for the subtotal on financial reports.

An account's identifying number.

Getting Started 146



account
segment

account type

accounting
cycle

accounting
equation

accounts
payable

accounts
receivable

acknowledge-
ment

actual costs

adjustments

Glossary

A group of numbers or characters within an account number that
carries specific meaning for the account. For example, the first five
numbers might identify the account category as asset.

Account categories are broken down into smaller groups called
account types. For example, for the category asset, you can have
the account types cash, inventory, and prepaid expenses.

The series of steps performed during each accounting period to
classify, record, and summarize financial data for a business and
produce the necessary financial information.

Assets = Liabilities + Owners' Equity. The relationship between the
worth of a business (assets) and the claims to that worth held by
creditors (liabilities) and owners (equity).

Amounts owed to others (a liability) for goods or services
purchased on credit.

Amounts owed to a business (an asset), usually by customers who
purchased goods or services on credit.

A formal declaration of the sales order by a customer.
Acknowledge dates are required to change the status of a sales
order to Open.

The total of all costs incurred on a job. Sage 500 ERP calculates
this figure by totalling all charges relating to a job.

In the General Ledger module, journal entries required at the end
of an accounting period to record an internal transaction and to
bring the ledger up to date. Adjustments can also be made to
invoices with credit or debit memos and to inventory quantities.
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aging

allocations

asset

audit trail

available
quantity

back orders

bad debt

balance
forward

balance sheet

Glossary

The act of analyzing accounts receivable or payable according to
how long they have been outstanding. The invoice date is
generally used as the base point for determining age. Many
businesses age receivables and payables in 30-day increments.

Amounts distributed from one or more source accounts to one or
more destination accounts.

A property or economic resource owned by a company. Typically,
assets include cash, marketable securities, accounts receivable,
inventory, land, buildings, equipment, and prepaid expenses.

A method of tracking transactions through each sequence of their
history so that all financial information can be traced. Certain
reports, such as AR Trial Balance and AP Trial Balance, should be
kept as part of your permanent business record for the audit trail.

The quantity of an item that is deemed to be available for sale or
use. This is the quantity on hand adjusted by the quantity on
order. Users can control whether quantities on sales orders,
purchase orders, or transfer orders affect the quantity available.

Ozrders placed by customers that have been at least partially
shipped, but are temporarily unfillable due to stock shortages. See
committed.

An uncollectable account receivable.

In the Accounts Receivable module, a method of computing
customers' statements that carries forward the previous month's
balance in total. See open item method.

In the General Ledger module, a standard financial report that
takes a snapshot of your business as of a specific date, showing a
company's assets, liabilities, and capital.
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base pricing

bid

bill of lading

billings

bin

bin ticket

blanket order

blind picking

blind
receiving

book quantity

build-to-order
kit

Glossary

A pricing method that uses a base price (a standard amount on
which you base the actual part prices) and percentages based on
that price.

An estimate of the steps, price, and schedule to complete a job.
Bids are the first stage in job completion. Customers often request
one or more bids (estimates) before giving their approval to begin
a job.

A receipt for a freight company displaying the shipment and
delivery address.

The amount for which a customer is invoiced for a job. Billings are
based on the established price of the job.

A location in your warehouse for storing inventory items.

A parts list helpful in returning parts to inventory after
disassembling an assembled Kkit.

A shortcut method of ordering or selling large quantities of items,
and receiving or delivering those items over a period of time.
Blanket orders can be contract or noncontract.

Requires that you manually enter the picked amount of an item
on a pick list.

Requires that you manually enter the picked amount of an item
on a receipt.

The quantity of an item you have recorded in your books as being
on hand. A physical inventory count may reveal shortages or
overages.

An item containing many components that are bundled into a
single inventory item at the time of order.
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business date

capital

caution box

change order

charges

chart of
accounts

close

committed

commodity
codes

company ID

Glossary

The default transaction and posting date. Appears as a default on
many reports and screens. You can change this date for reporting
purposes. Defined in the System Manager module.

See owner's equity.

A box that appears when you enter data incorrectly or when Sage
500 ERP wants to bring a point to your attention. Caution boxes
can contain error messages, notes, and warnings.

The document created when a modification is made to an existing
purchase order or sales order.

The actual costs incurred during each phase of a job.

In the General Ledger module, a list of all of a business' accounts,
usually grouped by account type.

The act of advancing the system to the next accounting period.
Each module has specific close functions. For example, a close in
the General Ledger module posts all earnings for the month to
year-to-date earnings.

Items that have been ordered by your customers, but have not yet
been fully or partially invoiced.

You can also commit sales order shipments, transfer shipments,
and customer returns if you want to perform all of the functions
of posting except the update to the general ledger. Inventory
quantities and cost tiers are updated, pending invoices and credit
memos are created, general ledger accounts and entries are
determined, and the Inventory Management module history is
updated. See back orders.

A means to classify items for tax and other regulatory purposes.

A code that identifies a company's records.
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completed

components

controls

cost method

cost of
carrying

cost of goods
sold

cost of
ordering

cost tier

count card

count cycle

count item

credit

Glossary

The status of a job indicating that all charges have been made
against the job.

Parts used to build a subassembly or finished item.

Items that make up the Sage 500 ERP windows. Examples of
controls include text boxes, option buttons, check boxes, window
or dialog box titles, and toolbar buttons.

The method used for determining the cost of the inventory items.

The overrhead costs incurred due to keeping items in inventory
over a period of time (for example, warehouse rent, insurance, and
shrinkage).

An account that tracks the costs of inventory sold.

The costs associated with each purchase order, other than the
vendor cost.

The cost and pricing structure for items in a company.

A printed card to facilitate the manual counting of inventory
items.

The period in which an item is included in a physical count. See
physical inventory count.

An item that has been selected to be physically counted.

An entry that decreases an asset or expense account or increases a
liability, capital, or revenue account.
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credit memo

cross-rate
derivation

current asset
current
liability

custom field

customization

Glossary

A method of decreasing a customer's liability to you or increasing
your liability to a vendor. For example, a credit memo is issued if
the vendor undercharged you for invoiced items.

The method of using two sets of currencies with a common
currency in each set to calculate the rate of exchange between the
other two currencies. For example, you need the rate of exchange
between the Hong Kong dollar and the Australian dollar and you
do not maintain an exchange rate between the two currencies.
You can calculate the rate if you have a rate between the US dollar
and the Australian dollar and you have a rate between the US
dollar and the Hong Kong dollar.

Assets that are cash or expected to be converted into cash within a
one-year period.

Liabilities that will be due within a one-year period.

Field you can establish to further define and sort information in
reports.

See form customization.
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customization
level

debit

debit memo

demand

department

Desktop

detail

Glossary

The set of attributes that determines whether a customization
displays for a user. The customization level specifies user-, group-,
and company-ID criteria that must be met for the customization
to display. The heirarchy of customization levels is, from lowest to
highest:

1 Forms shipped with Sage 500 ERP (no customizations)
2 Site-level (all users)

3 Company-level (all users in a specific company)

q

Group-level (all users that are members of a specific group
as their default group)

User-level (specific user)

6 User- and company-level (specific user in a specific
company)

When a user opens a window that has customizations, the
customization with the highest level for that user is activated.

An entry that increases an asset or expense account; or decreases a
liability, capital, or revenue account.

A method of increasing a customer's liability to you or decreasing
your liability to a vendor. For example, a debit memo is issued if
the vendor overcharged you or you returned merchandise to the
vendor.

The projection of the usage of an item for a future period.

Used to set up contacts and ship-to addresses on blanket purchase
orders, purchase orders, and requisitions. Departments consist of
an address and a department.

The user interface that appears when you start Sage 500 ERP. The
Desktop is the starting point for all tasks.

The detailed information (quantity, unit cost, unit price, and
priority) assigned to a job code for a phase of a job. Job codes are
used to break down the charges required to complete a phase.
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discount

distribution

double-entry
accounting

drill around

drill down

drop ship

earnings

emergency
purchase
order

EOQ

equity

estimated cost

Glossary

A deduction from the invoice price of goods. An early payment
discount is offered for payment made within a specified time
frame. An invoice discount reduces the charges to the customer
for a line item or the total invoice (such as for quantity purchases).
You can take advantage of discounts offered by other vendors with
the Accounts Payable module and offer discounts to your
customers with the Accounts Receivable module.

The process of selling goods from a warehouse to a customer.

A system for recording transactions that requires the accounts to
be in balance at all times, so that debits always equal credits.

Retrieving additional data of a greater detail for a specific entry
(usually retrieves related data or transactions for a specific
transaction).

Retrieving more detailed data directly related to a specific entry.

Purchase order items that are shipped directly from the vendor to
the customer.

The difference between revenues and expenses.

A recommended purchase order for a purchase product line that
meets the vendor's target purchase requirements, but contains
only those items that are in need of replenishment.

The Economic Order Quantity. This is the most economical
quantity of the part for you to buy based on factors such as
quantity breaks you may get from the vendor, overhead, etc.

The rights or financial claims of owners, stockholders, or creditors
to the company assets.

The projected cost of a job based on the quantities of resources
defined as job codes.
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exchange rate

expenses

expiration
date

exposed
objects

finance
charge

fiscal year

form
customization

free on board
(FOB) point

freeze count

freight class

grid

Glossary

The term used for the rate at which one currency can be
exchanged for another. For example, one British pound may be
equal to $1.50 USD.

The amount of assets consumed or services used in the process of
earning revenues.

The date on which a quote, lot, or price will no longer be
honored.

Objects, such as properties and methods, that Sage 500 ERP allows
you to access. See script.

A charge assessed to an account because of past-due invoices.

A time span used for accounting that you can divide into distinct
accounting periods. A fiscal year does not necessarily coincide
with the calendar year. See period.

A collection of edits made to a form in Sage 500 ERP. See
customization level.

The point at which the title of ownership for items ordered is
transferred. The FOB point determines the tax schedule. For an
origin FOB, the shipping warehouse's tax schedule is used. For a
destination FOB, the customer location's tax schedule is used.

A process that records the current inventory totals for use in a
physical count.

A shipping classification that determines the amount to apply for
the cost of shipping.

Tables appearing in the bottom half of many task windows to
simplify line entry with mouse and keyboard shortcuts. Grids
contain column and row format.
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gross profit

hard override

home
currency

immediate
picking

in house

in progress

income
statement

inquiry

inventory

invoice

issues

Glossary

The sales amount minus the cost of goods sold amount.

The act of manually removing a link from a voucher line to a
purchase order line during matching.

The currency in which the company conducts business and
reports their financial condition.

The act of gathering the items needed to fill a simple sales order in
Process Sales Orders immediately after it is entered in Enter Sales
Orders and Quotes. Orders with complex picking requirements
must be processed in Create Pick List.

A job set up for internal company use for tracking expenditures
for projects such as product research and development, marketing
campaigns, or office remodeling. In-house jobs do not have a
price, and billings and payments cannot be posted against them.

A job status indicating that job-related transactions (change
orders, charges, billings, credit/debit memos, and payments) can
be processed.

A standard financial report that reflects sales, expenses, and the
resulting net income or loss for a given period.

A means of accessing stored information.

Material or items owned by a company that will be supplied to
other companies or individuals.

An itemized statement of goods bought and sold; also called a bill.

The process of relieving inventory (usually for internal purposes).
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job codes

journal

journal entry

kits
lead time
liability

limit tolerance

line pricing

lookup

lot number

maintenance

Glossary

Codes used to identify the different types of costs for a phase,
including labor, materials, subcontracting, equipment, overhead,
or miscellaneous items.

The place where you originally record transactions. Detail or
summary journal information is posted to the General Ledger
module.

A transaction recorded in a journal.

Groups of parts, labor, miscellaneous charges, or comments that
are often ordered together.

The number of days it takes to receive an item after generating a
purchase order.

A debt owed. These usually include accounts payable, notes
payable, income taxes, and dividends paid to stockholders.

An amount in your home currency that a customer can exceed its
credit limit before issuing a warning.

Pricing based on the method (Margin, Markup, or Base) you have
entered.

A query tool to conduct information searches according to
conditions you define. With Lookup, you can retrieve and insert
data into the current field. The magnifying glass button appearing
to the right of any field invokes Lookup.

A unique code that usually identifies a batch of an item for
tracking and identification purposes.

The act of adding, changing, or removing data.
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matching

minimum
purchase
requirement

module

national
account

natural
currency

Navigator

noninventory
item

nonstock item

offsetting
account

Glossary

The process of comparing the purchase order amount or quantity
against the invoice amount or quantity.

A minimum order requirement for a purchase product line
specified by a vendor.

An individual accounting system of Sage 500 ERP that handles a
specific area of accounting, such as General Ledger or Accounts
Payable.

A grouping of customers into a two-level relationship, consisting
of a top-level parent customer and an unlimited number of
subsidiary customers assigned to the parent customer. A national
account parent can be authorized to pay the invoices of the
subsidiary.

The currency in which a document is entered.

A query tool to conduct information searches according to
conditions you define. With Navigator, you can retrieve a
complete record of information from any database linked to the
current field. The flashlight button appearing next to any field
invokes Navigator.

Items that are not part of your inventory, such as freight, sales tax,
or consulting fees.

Items that are not part of your regular inventory. See noninventory
item.

The account used in the General Ledger module to balance a
transaction.
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open item
method

open period

order point

owner's equity

packing list

partial receipt

partial
shipment

password

password
access

path

payables

payment

period

Glossary

In the Accounts Receivable module, a method of producing
customer statements that lists prior month's invoices individually.
See balance forward.

The time span to which you are currently posting transactions.

The quantity of an inventory part that, when reached, marks the
point at which you wish to order more.

Assets minus liabilities.
A list of the items included in a shipment.
Created when not all of the items ordered are received.

Created when all of the items ordered are not shipped.

A security code word used to gain access to software and
databases. Both the network and Sage 500 ERP have password
protection. You must enter the correct password before you can
access any of the tasks. Passwords are set up in the System
Manager module.

The tasks available to a particular password.

The location of a file in relation to a drive and directory.

The money owed to vendors for goods and services purchased on
credit.

Money received from a customer to pay an outstanding debt.

A segment of a fiscal year. See fiscal year.
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phases

physical
inventory
count

pick list

pick ticket

posting

preassembled
kit

preferred bin

price sheets

priority

probability
percentage

product line

Glossary

Phases are the steps involved in completing a job. A job must have
at least one phase. A phase may include detail, in which case you
can assign job codes to break down the charges required to
complete the phase.

The process of counting your inventory to compare actual
quantities with the quantities you have recorded in your books.

A list used for gathering the components needed to assemble a
subassembly.

A list used for gathering the items needed to fill an order.
The act of applying transactions to general ledger accounts.

Items that are combined to make a single inventory item. See
build-to-order kit.

The favored location for an item within a warehouse.

A list containing the base prices used when pricing customer sales
orders.

A whole number between 1 and 999 that you assign to job code
line items. Priority is used to determine the order in which detail
items appear on reports. More than one detail item in each phase
can have the same priority.

The likelihood of a quote being converted to an order.

A grouping of related items that can be analyzed for sales or
purchasing purposes.
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purchase
order

purchase
product line

quantity on
hand

quote

rank

realized gain
or loss
(RGOL)

receiver

receiving
ticket

reconcile

record

recurring
journal entry

Glossary

A document used for purchasing both inventory and
noninventory items, which defines the quantities, prices, and
vendors from which the items will be purchased.

A group of items that can be purchased together from the primary
vendor with a cost benefit for higher quantities ordered.

The quantity of a stocked product that is owned by the
distributing company. This quantity is normally maintained “on
the shelf” in the distributor's warehouse.

An estimate of the price of goods or services, usually requested by
a customer. See bids.

The process of sorting and assigning percentages to items based on
the cost of goods sold, gross margin, quantity sold, and hits.

The loss or gain due to changes in the exchange rate when a
transaction is completed (paid) in a currency other than the
currency of the company (home currency). RGOLs are included in
the determination of net income. See unrealized gain or loss.

A statement that shows a shipment of goods. Also called a receipt.

Used to record items received, quantity received, receipt unit of
measure, and associated weight and volumes on receipt of goods.

The method used to balance a bank account against a bank
statement.

A collection of related items of information or “data elements,”
such as customer or vendor information, stored together in a file.

In the General Ledger module, a type of transaction that needs to
be posted on a regular basis, such as rent or depreciation.
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replenishment

replenishment

source

requested
date

requisition

retained
earnings

returns

revaluation

revenue

safety stock

sales order

script

Glossary

The process of restocking items in a warehouse.

The means of restocking an inventory item; it can either be
purchased or transferred from another warehouse, or assembled in
the same warehouse.

The date by which an order is needed.

A formal request for goods or services to be purchased.
Requisitions are not typically created to replenish normal
inventory, and are not required to create a purchase order.

Earnings accrued from prior years' operations. In the General
Ledger module, Sage 500 ERP automatically tracks year-to-date
earnings for you and posts them to the retained earnings account
at year end.

Items that are returned to inventory.
The process of computing the unrealized gain or loss.
Income produced by the company; also called sales.

The quantity of an item that is maintained in the warehouse
above the demand projection to avoid unforeseen stock-out.

A customer request for merchandise or services.

A collection of statements that performs calculations, modifies
data on a form, or interacts with other desktop applications. Using
the Customizer Forms Customization task, scripts are associated
with controls (for example, custom toolbar buttons), so that the
script runs when the user selects the control.
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scrolling

seasonal item

security event

security group

serial number

ship label

shipment

shrinkage

soft override

source

spot rate

Glossary

To move through text using scroll bars or arrow keys (up, down,
left, or right) in order to see parts of the file or list that do not fit
in the window.

Any category of a stocked item.

Tasks, mostly overrides, predefined by Sage for which permission
is defined in System Manager Maintain Security Groups. Events
are application specific. Permission level is either Yes (user
permitted to perform the security event) or No (permission
denied).

A group of users who have access to the same companies, menus,
tasks, and events. Defined in System Manager Maintain Security
Groups.

A unique code assigned to an item for tracking and identification
purposes.

A label with a customer's name and address that a vendor attaches
to a package.

The cargo that a vendor sends to a customer.

The loss of inventory items due to factors such as faulty
manufacturing or deterioration, or theft during production,
storage, or transit.

The act of allowing a voucher line causing a match failure to be
posted without changes.

A code used to identify how a vendor acquired a customer.

The exchange rate at the time of the transaction. Also known as
the daily rate.
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standard cost

subassembly

subsidiary
company

subcontract-
ing

substitute
item

target
purchase
order

target
purchase
requirement

task

terms

third currency

Glossary

A cost stated in terms of the stocking unit of measure.

An item listed as a part in your inventory that is made up of
component parts.

A company having its own set of accounts, but which combines
its account balances with those of the parent company for
reporting purposes.

Hiring a nonemployee or company to complete some portion of a
job.

A replacement for an ordered item that is unavailable.

A recommended purchase order for a purchase product line that
meets the vendor's target purchase requirements.

A purchase requirement for a purchase product line specified by a
vendor in order to get some cost benefit.

Any choice listed on a menu or found on the Desktop that allows
the user to perform an activity. Tasks are predefined by the system
and have permission levels defined in System Manager Maintain
Security Groups.

Payment terms on an invoice. For example, terms of 2/10, net 30
means that a bill paid within 10 days receives a 2% discount;
otherwise, the undiscounted amount must be paid within 30 days.

A currency that is neither the home currency nor the natural
currency.
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tolerance

transaction

trial balance

unit of
measure

unrealized
gain or loss

usage

use tax

vendor

Glossary

The degree to which a voucher quantity, cost, or receipt quantity
can deviate from the purchase order quantity or cost. Tolerances
also determine the action that results from a failure that falls
within the specified allowances.

An entry made in any of the Sage 500 ERP modules that increases
or decreases an account in the General Ledger module.

The general ledger report that lists the balances of all accounts in
the General Ledger module. Used to verify that all debits equal
credits in the accounts.

The method by which an individual item is stocked, purchased, or
sold.

When a transaction is completed (paid) in a currency other than
the currency of the company (home currency), the loss or gain
due to changes in the exchange rate is called a realized gain or
loss. An unrealized gain or loss is the amount of the gain or loss if
the transaction were completed at the current exchange rate.

Total consumption of an item by the means of sale, transfer, or
assembly.

Excise taxes taken for items purchased in one jurisdiction (for
which you do not pay sales tax) and used in another jurisdiction
(which obligates you to pay a use tax).

A company from which you purchase goods or services.
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warehouse

wave picking

write-off

zone

Glossary

The location in which the inventory is physically located.

Picking for a group of orders in one pick list. During wave picking,
the picker makes one round of the warehouse and picks each item
once for all orders requiring that item. In wave summary picking,
the sorting and packing of items occurs after picking as a separate
step. In wave detail picking, the sorting and packing of items can
occur while picking is being performed. Wave picking is also
referred to as group picking or batch picking.

The portion of a customer's unpaid invoice or billing balance that
is forgiven.

Groups or ranges of bins in a warehouse. Zones can correspond to
how inventory is segregated in the warehouse by such factors as
storage type, geographical area, product line, supplier, customer,
or traffic pattern. Zones can be set up for warehouses only if the
Warehouse Management module is activated.
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Index

A

account numbers, searching for 59
Activities menu 52
Alerts, Sage 500 ERP 15
analysis reports 117
Analyze 67
Analyzer
creating filters 96
purpose 93
using the toolbar 95
viewing data 95
audit reports 117
authentication options, logon 29

B

batches
entering information 108
posting 111
setup options 106
statuses 109

Business Insights 65
analyze 67
drill into 67
explore 66
manage 67

Business Insights Analyzer
accessing 93
creating a chart 99
creating a pivot table 98
creating filters 96
Data View grid 97
using the toolbar 95
viewing data 95

Business Insights Dashboard 5, 25, 103

Business Insights Explorer 100
buttons, definitions 68
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preferences, setting user 53
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S
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search 60
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